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GARANTIA

Este produto é garantido contra defeitos de material e fabricacido pelo periodo especificado
na nota fisal de venda.

A garantia inclui somente o conserto e substituicdo de componentes ou partes defeituosas
sem Onus para o cliente. Ndo estdo cobertos defeitos resultantes de: utilizacdo do
equipamento em condigdes inadequadas, falhas na rede elétrica, fen6menos da natureza
(descargas induzidas por raios, por exemplo), falha em equipamentos conectados a este
produto, instalagbes com aterramento inadequado ou consertos efetuados por pessoal nao
autorizado pela DSPRO.

Esta garantia ndo cobre reparo nas instalagdes do cliente. Os equipamentos devem ser
enviados para conserto na DSPRO.

Apesar de terem sido tomadas todas as precaugdes na elaboragdao deste documento, a
empresa ndo assume qualquer responsabilidade por eventuais erros ou omissdes, bem como
nenhuma obrigacdo é assumida por danos resultantes do uso das informagdes contidas neste
manual. As especificagdes fornecidas neste manual estdo sujeitas a alteragdes sem aviso
prévio e ndo sdo reconhecidas como qualquer espécie de contrato.
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CONVENCOES

Para facilitar o entendimento, foram adotadas, ao longo deste manual, as seguintes
convengoes:

hyperlink - Endereco na internet ou e-mail.

Comando ou Botdo - Sempre que for referido algum comando, botdo ou menu de algum
software, esta indicagdo estara em italico.

As notas explicam melhor alguma funcionalidade ou detalhe apresentado no texto.

Procedimento que deve ser seguido a fim de evitar danos. Deve ser lido com cuidado e pode
evitar grandes dificuldades.

Indica risco de choque elétrico caso as observagdes ndo sejam seguidas.
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1. INTRODUGAO

Parabéns, vocé acaba de adquirir um produto da linha DSNAKE, uma solugdo flexivel e
totalmente redundante para distribuicdo digital de dudio nas mais diversas aplicagdes. Com o
protocolo DSPRO de baixa laténcia e alto nivel de protecdo, é possivel transportar até 80
canais de dudio com qualidade profissional em um Unico cabo de rede cat5.

Além de substituir o multicabo analdgico, o DSnake também pode ser usado como interface
de gravacdo, splitter e patchbay digital.

Todos os equipamentos da série contam com interfaces de rede redundantes, e mecanismos
inteligentes de comutagdo automatica de link para garantir que o dudio ndo pare e a troca de
link ndo gere artefatos (“clics”) no audio.

O DSnake possui geréncia remota através do software DSManager, que permite controlar
todos pardmetros do sistema, como ganhos dos pré-amplificadores, Phantom power, taxa de
amostragem e muito mais, a partir de um PC conectado tanto pelo proprio Ethemet quanto
pela Interface RS-232.

A funcionalidade de gravacdo do DSManager permite capturar até 80 canais de audio
simultaneamente utilizando a placa de rede do PC enquanto a janela de patchbay digital é
capaz de enderecar qualquer entrada para qualquer saida do sistema.
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2. DSNAKE MODULAR

O DSnake Modular € um gabinete com 5 slots para placas de I0 que vem equipado com uma
unidade central de processamento CPU e uma fonte de alimentagao.

O moédulo de CPU é a unidade de processamento digital de sinais responsavel pela
transferéncia do audio entre todos os equipamentos. Possui 4 interfaces digitais Ethernet em
conectores Neutrik® Ethercon® por onde o audio é transmitido digitalmente sob o protocolo
DSPRO.

As portas MAIN e BACKUP sdo as responsaveis por ligar de forma redundante todos os
equipamentos do caminho principal, enquanto as portas SPLIT 1 e 2 sdo retransmissoras
para envio de uma copia do sinal a outros equipamentos como mesas de monitor ou
gravagao.

As portas MAIN e BACKUP possuem um LED de Link/atividade que indica que o sinal digital

esta trafegando e um LED ACTIVE que indica quando uma porta estd recebendo
corretamente os dados por aquela interface. As portas SPLIT também possuem o LED

Link/atividade.
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Figural. DSnake Modular

1. Saida de Audio - Uma das oito saidas analdgicas balanceadas em nivel de linha
em conector XLR macho do moédulo DSM-DAS8, que pode estar instalado em qualquer
um dos 5 slots de I0.

2. Entrada de Audio - Uma das oito entradas analdgicas balanceadas pré-
amplificadas para microfone ou linha em conector XLR fémea do mddulo DSM-
DA8PRE, que pode estar instalado em qualquer um dos 5 slots de IO.

3. LEDs do mdédulo DSM-ADSPRE - A fileira superior indica em verde a presenca
de sinal, e em vermelho o clip, enquanto a fileira inferior indica em amarelo a
presenca de alimentagdo Phantom.
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4. Interface digital de audio DSPRO - Interface digital de dudio em conector
RJ45 Ethercon®. As interfaces MAIN e BACKUP sdo usadas no link principal de forma
redundante, enquanto as interfaces SPLIT 1 e SPLIT 2 podem ser usadas para envio
do audio para outros destinos sem necessidade de switches externos.

5. LEDs principais - Na CPU, 6 LEDs indicam as configuragdes do sistema:

e LED CLK MSTR indica que o relégio do equipamento esta sendo usado de referéncia
na rede.

e LED STACKED indica se o equipamento esta operando no modo anel ou modo estrela,
de acordo com a chave seletora (*7).

e LEDs 48/96kHz indicam a taxa de amostragem sendo usada, que deve ser a mesma
em todos os equipamentos da rede.

e LEDs CH 1..40 e CH 41..80 indicam quais os canais que as interfaces de audio desse
equipamento estdo utilizando no rede. Ambos LEDs acesos indicam patchbay ativo
(veja o capitulo 8.4 - Janela Patchbay).

6. Chave CH RANGE - Seleciona o intervalo de aanais utilizado pelas interfaces de
audio na rede. Através do software de geréncia é possivel ativar o modo avancado de
patch, onde cada canal tem seu caminho configurado de forma independente. Nesse
caso a chave perde sua fungdo, o que é indicado pelos dois LEDs de range de canais
acesos (veja o capitulo 8.4 - Janela Patchbay).

7. Chave STACKING - Seleciona o modo de funcionamento do equipamento entre
anel (ou stacked) ou estrela. No modo anel os equipamentos sdo conectados de
maneira a formar um circulo, enquanto no modo estrela devem ser conectados todos
em paralelo, através de switches.

8. Interface REMOTE/RS-232 - Interface para gerencia através do PC, que
também pode ser feita por quaisquer das interfaces Ethernet.

9. Chave de Liga/Desliga - Chave principal de energia do equipamento.
10.Fusivel - Fusivel geral de protecdo.

11.Conector de Entrada de Alimentagao - Conector de entrada e alimentacdo
AC. Possui selecdo automatica de 90-250VAC.

12.LEDs do Médulo de Alimentacdo - O LED ON indica que o equipamento esta
ligado, enquanto o LED STAND-BY indica, para o caso de haver fonte redundante
instalada, a fonte que estd em modo de espera.

2.1. Médulo de entrada ADS8PRE (DSM-ADSPRE)
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Figura 2. M6dulo DSNAKE-ADSPRE

Médulo com 8 entradas de microfone ou linha em 8 conectores XLR para DSnake Modular.
Podem ser inseridos até 5 desses mddulos, de forma a deixar o DSnake com 40 canais de
entrada de linha ou microfone.
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Para cada entrada existem dois LEDs a direita: Os LEDs SIGNAL além de indicar a presenga
de sinal na cor verde, indica o clip do canal na cor vermelha. Os LEDs +48V sdo de cor
amarela e indicam se a referida porta esta com Phantom power ativado.

2.2. Médulo de saida DA8 (DSM-DAS8)
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Figura 3. Modulo DSNAKE-DAS

Médulo com 8 saidas de linha em conectores XLR para DSnake Modular. Podem ser inseridos
até 5 desses mddulos, de forma a deixar o DSnake com 40 canais de saida.

2.3. Médulo de alimentacao AC-PSU (DSM-ACPSU)
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Figura4. Moédulo de Alimentacéo (DS M-ACPSU)

O DSnake Modular pode ser equipado com um fonte de alimentacgdo extra para trabalhar
com redundancia de alimentagdo.

Essa segunda fonte é idéntica a primeira e trabalha em modo de espera enquanto a principal
estiver funcionando. Qualquer falha na alimentacdo primaria, tanto na linha quanto na
propria fonte, provocam um chaveamento para essa fonte sem afetar o comportamento do
equipamento, garantindo assim um maior nivel de confiabilidade ao sistema.
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3. DSNAKE COMPACTG64R

O DSnake Compact64R é um gabinete com 2 unidades de rack e 8 slots para placas de 10
que vem equipado com uma unidade central de processamento CPU e uma fonte de
alimentacgdo.

As conexdes desse equipamento sdo todas realizadas na face traseira, enquanto no painel
frontal um painel LCD é disponibilizado para monitoragdo das configuragdes e status do
equipamento.

O mddulo de CPU é o mesmo do DSnake Modular, sendo responsavel pela transferéncia do
audio pela rede nas 4 interfaces digitais Ethernet com protocolo DSPRO.

As portas MAIN e BACKUP sdo as responsaveis por ligar de forma redundante todos os
equipamentos do caminho principal, enquanto as portas SPLIT 1 e 2 sdo retransmissoras
para envio de uma copia do sinal a outros equipamentos como mesas de monitor ou
gravagao.

Além dos slots de I0, o equipamento disponibiliza um slot para fonte de alimentacio
redundante que fica integrada ao equipamento e assegura uma maior toleréncia a falhas
para o sistema.

O equipamento conta ainda com um slot de GPIO por onde é disponibilizada entrada e saida
de Word Clock, além, de auxiliares MIDI e RS422.
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Figura5. DSnake Compact64R

1. Interface REMOTE/RS-232 - Interface para gerencia através do PC, que
também pode ser feita por quaisquer das interfaces Ethernet. A serial é no padrao
RS232, 57600bps, 8-N-1.
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2. Display frontal - Display de LCd por onde é possivel verificar algumas
configuragbes e estados do equipamento como Nome, endereco IP, Temperatura e
Stacking. A tecla Next navega entre os estados e a tecla Enter seleciona o item em
exibicao.

3. LEDs de Status - Indicam o status do equipamento e dos links:

a. LINK: indica a presenga de link nas interfaces DSPRO MAIN e BACKUP (A e
B)

b. ACTIVE: indica se a interface estd recebendo audio de outros equipamentos.
A forma como esse led pisca ou acende indica o estado da redundancia:

i. Aceso: O audio esta chegando totalmente redundante

ii. Piscando: (00000----- ): Um ou mais canais de audio ndo estdo
chegando pelas duas interfaces MAIN e BACKUP, ou seja, se houver
falha no link, alguns canais podem parar.

iii. Piscando (0-0-0-----): Um ou mais canais de audio ndo chegam por
nenhuma das interfaces. Esse status é dependente do pacth de saida
configurado no equipamento. Somente os canais que o equipamento
precisa receber sdo levados em consideracao.

iv. Apagado: Ndo ha dudio chegando na interface

c. PSU A e B: Indica o estado da fonte de acordo com a cor. Verde a fonte
estd OK, Laranja a fonte estd em stand-by, Vermelho a fonte ndo esta
alimentada ou estd com defeito e Apagado a fonte ndo esta presente.

d. Stack: Indica o modo de operagdo do equipamento. Ligado indica Stacking

ON, que é o modo ANEL. Apagado é Stacking OFF, configuracgdo do modo
ESTRELA.

e. Alarm: Aceso indica a presenca de uma falha grave no equipamento.

4. Fonte Principal: Modulo de alimentagdo principal do equipamento, com conector
de entrada AC, chave de liga/desliga, LEDS de status e porta fusivel.

5. Fonte backup: Modulo de alimentacgdo backup do equipamento, com conector de
entrada AC, chave de liga/desliga, LEDS de status e porta fusivel.

6. Interface digital de audio DSPRO - Interfaces MAIN e BACKUP do link digital
de audio usadas no link principal de forma redundante

7. Interface digital de audio DSPRO - Interfaces SPLIT sdo utilizadas para o
envio de audio para outros destinos como PC ou MAC de gravacdo.

8. LEDs principais - Na CPU, 6 LEDs indicam as configuragdes do sistema:

a. LED CLK MSTR indica que o reldgio do equipamento estd sendo usado como
referéncia para a rede.

b. LED STACKED indica se o equipamento estd operando no modo anel ou modo
estrela.

C. LEDs 48/96kHz indicam a taxa de amostragem sendo usada, que deve ser a
mesma em todos os equipamentos da rede.
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d. LEDs CH 1..40 e CH 41..80: N&o possuem fungdo no Compact64R. Devem
estar os dois ligados

9. MIDI - Portas Midi In/Out (consulte a DSPRO sobre suporte em firmware)

10.Clock - Entrada e saida de word clock
11.RS422 - Interface RS422 (consulte a DSPRO sobre suporte em firmware)

12.Slots de I/O - Slots para interfaces de entrada e saida analdgicas ou
digitais
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4. DSNAKE BRIDGE

O DSnake Bridge é um gabinete com 1 unidades de rack e 2 slots para CPUs que é utilizado
para a conversdo entre padres de audio digital multicanal. Atualmente, além da interface
digital DSPRO (CPU 1) o equipamento suporta as CPU MADI64, porém futuramente CPUs
com outras interfaces serdo incorporadas a linha.

As conexdes desse equipamento sdao todas realizadas na face traseira, enquanto no painel
frontal um painel LCD ¢é disponibilizado para monitoracdo das configuragdes e status do
equipamento.

O modulo de CPU 1 é o mesmo do DSnake Modular, sendo responsavel pela transferéncia do
audio pela rede nas 4 interfaces digitais Ethernet com protocolo DSPRO.

As portas MAIN e BACKUP sdo as responsaveis por ligar de forma redundante todos os
equipamentos do caminho principal, enquanto as portas SPLIT 1 e 2 sdao retransmissoras
para envio de uma copia do sinal a outros equipamentos como mesas de monitor ou
gravagao.

O equipamento disponibiliza um slot para fonte de alimentacdo redundante que fica
integrada ao equipamento e assegura uma maior tolerdncia a falhas para o sistema.

A CPU2 pode ser equipada com a CPU MADI ou CPU MADI Dual, que possuem uma ou duas
interfaces no padrdo MADI64 e permite que o dudio seja mapeado entre as interfaces MADI e
a interface digital DSPRO.

Adicionalmente o equipamento conta ainda com um slot de GPIO por onde é disponibilizada
entrada ou saida de Word Clock, além, de auxiliares MIDI e RS422.

Figura6. DSnake CompacR

1. Display frontal - Display de LCD por onde é possivel verificar algumas
configuragdes e estados do equipamento como Nome, enderego IP, Temperatura e
Stacking. A tecla Next navega entre os estados e a tecla Enter seleciona o item em
exibigao.

2. LEDs de Status - Indicam o status do equipamento e dos links:
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a. LINK: indica a presenca de link nas interfaces DSPRO MAIN e BACKUP (A e

B) da CPU 1 e CPU2. Caso a segunda CPU possua outro tipo de interface, o
status dessa interface serd indicado.

b. ACTIVE: indica se a interface estd recebendo audio de outros equipamentos.
A forma como esse led pisca ou acende indica o estado da redundancia:

i. Aceso: O audio esta chegando totalmente redundante

ii. Piscando: (00000----- ): Um ou mais canais de audio ndo estdo
chegando pelas duas interfaces MAIN e BACKUP, ou seja, se houver
falha no link, alguns canais podem parar.

iili. Piscando (0-0-0-----): Um ou mais canais de audio ndo chegam por
nenhuma das interfaces. Esse status é dependente do pacth de saida

configurado no equipamento. Somente 0os canais que o equipamento
precisa receber sdo levados em consideragao.

iv. Apagado: N3o ha audio chegando na interface

c. Power A e B: Indica o estado da fonte de acordo com a cor. Verde a fonte
estd OK, laranja a fonte estd em stand-by, vermelho a fonte ndo esta
alimentada ou estd com defeito e apagado a fonte ndo estad presente.

d. Alarm: Aceso indica a presenca de uma falha grave no equipamento.

3. Interface REMOTE/RS-232 - Interface para gerencia através do PC, que

também pode ser feita por quaisquer das interfaces Ethernet. A serial é no padrao
RS232, 57600bps, 8-N-1.

4. Fonte backup - Modulo de alimentacdo backup do equipamento, com conector de
entrada AC, chave de liga/desliga, LEDS de status e porta fusivel.

5. Fonte Principal - Modulo de alimentacédo principal do equipamento, com conector
de entrada AC, chave de liga/desliga, LEDS de status e porta fusivel.

Conector AC Principal - Conector de entrada AC da fonte principal
. Conector AC Backup - Conector de entrada AC da fonte backup

MIDI - Portas MIDI In/Out

© ® N o

Clock - Entrada ou saida de word clock. A diregcdo da porta (entrada/saida)
é configurada via DSManager

10.Interface digital de audio DSPRO - Interfaces MAIN e BACKUP do link digital
de audio usadas no link principal de forma redundante

11.Interface digital de audio DSPRO - Interfaces SPLIT sdo utilizadas para o
envio de dudio para outros destinos como PC ou MAC de gravacdo.

12.LEDs principais - Na CPU, 6 LEDs indicam as configuragdes do sistema:

e. LED CLK MSTR indica que o reldgio do equipamento estd sendo usado como
referéncia para a rede.

f. LED STACKED indica se o equipamento esta operando no modo anel ou modo
estrela.

g. LEDs 48/96kHz indicam a taxa de amostragem sendo usada, que deve ser a
mesma em todos os equipamentos da rede.
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h. LEDs CH 1..40 e CH 41..80: N&do possuem funcdo no DSnake Bridge. Devem
estar os dois ligados.

13.MADI 1 Elétrico - Conectores BNC 750hms de entrada e saida de &udio no
padrdo MADI64 48kHz.

14.MADI 1 Otico - Conectores SC de fibra multimodo para audio no padrao MADI64
48kHz.

15.MADI 2 Elétrico - Conectores BNC 750hms de entrada e saida de audio no
padrdo MADI64 48kHz.

16.MADI 2 Otico - Conectores SC de fibra multimodo para audio no padrdao MADI64
48kHz.

17.Host - Porta Ethemet para gerencia e upgrade de firmware da CPU MADI.
18.LEDS de Status: Leds indicadores do status da CPU MADI:
Stacked: Para uso Futuro

a.
b. Clock Master: Para uso Futuro

o

Power: Indica a presenca de alimentagdo.

d. Alarm: Indica falha na CPU.

4.1. Modos de Operacao do DSnake MADI Bridge

4.1.1. Modo MADI 64

O modo MADI 64 permite que equipamentos que possuem interface MADI (como mixers e
roteadores) possam receber e transmitir canais de dudio através da rede DSPRO (Figura 7).
Nesse modo de operacdo todos os canais possuem conversores de taxa de amostragem
integrados e o sincronismo de reldgio pode ser derivado da rede DSPRO, entrada de word
clock ou reldégio regenerado da porta MADI.

Ethernet DSk ADIde

MADI Coaxial

ou Fibra

EEEEEEEEEEEEesll 30 T

Figura7: DSnake MADI Bridge no modo MADI 64

Configuragcao do DSnake MADI Bridge no modo MADI64

1. Abra a tela Equipments do DSManager e selecione o DSnake MADI Bridge a ser
configurado (Figura 8);
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DSMAKE Metwork Management - Optical_Converter.dsf EI@

File Edit Tools Help

Input Cha... | Output Ch...

Full Equipment List

F)TRO DSNAKE o Redundancy: Redundancy OK

Figura8: Abrindo janela do DSnake MADI Bridge para configuragéo

2. Na figura do equipamento, clique em uma das portas MADI para abrir a configuracdo
da interface (Figura 9);

Figura9: Selecdo das portas MADI

3. Em Mode, selecione a opgdao MADI 64 (Figura 10)

MADI Global Config

Mode Clock Reference:

MADI 64

Media Converter PORT 2

Electrical Interface Status: Electrical Interface Status:

Mo Signal No Signal

Optical Interface Status: Optical Interface Status:
Mo Signal Mo Signal

Input Interface Selection: Input Interface Selection:

Active Input Interface: Active Input Interface:
None

Figura10: Selegéo do modo MADI 64
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4. Em Input Interface Selection, escolha a interface de entrada (elétrica ou ética) desejada
ou deixe no modo Automatic para que a eswlha seja feita automaticamente com base na
detecgdo de sinal valido (Figura 11). No caso de sinal valido nas duas interfaces, a dtica terd
preferéncia. A transmissdo é feita simultaneamente nas portas elétricas e Oticas, sem
necessidade de configuragao;

MADI Global Config

Mode

| MADI 54 =

Clock Referenca:

PORT 1
Electrical Interface Status:
Ho Signal

Optical Interface Status:
No Signal

PORT 2

Electrical Interface Status:

No Signal

Optical Interface Status:

Mo Signal

Input Interface Saelection:
Automatic

A
Electrical
Optical

Figural1l: Selecdo da interface de entrada

Input Interface Selection:
Automatic

Active Input Interface:

5. Selecione o relégio de transmissdo da porta MADI (Figura 12):
a) System - Reldgio derivado do sincronismo do sistema (rede DSPRO)
b) External - Sinal extemo de word clock (48kHz)

c) MADI 1 - Reldgio regenerado da interface MADI 1 (recomendado para conexao
com mixers e roteadores)

MADI Global Config

Mode

| MADI 64 =

PORT 1

Clock Reference:
System
External
MADI 1

Electrical Interface Status: Electrical Interface Status:

Neo Signal

Optical Interface Status:
Neo Signal

Input Interface Selection:
| Automatic

Active Input Interfacea:

Figura 12: Configuracdo de reldgio
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Optical Interface Status:

Mo Signal

Input Interface Selection:

Automatic

Active Input Interface:
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6. Faca os mapeamentos dos canais de audio utilizando as telas Input Patch e Output Patch
do DSManager, conforme descrito na secdo 8.4 (Janela Patchbay). No mdédulo MADI Dual
apenas as entradas da porta MADI 1 podem ser enderecadas para a rede DSPRO e o patch
de saida é comum para ambas as portas. As entradas da porta MADI 2 sé sdo utilizadas no
modo conversor 6tico.

4.1.2. Modo Conversor Otico

Quando o DSnake MADI Bridge opera no modo conversor 6tico (media converter),
os dados recebidos nas portas elétricas sdo encaminhadas para as portas oticas (e
vice-versa) de forma transparente, com atraso inferior a 2ns, conforme a Figura 13.

iil...dspro |,

‘®
DSNAKE CFU MADI

Figura 13: Fluxo de dados no modo conversor ético

O modo conversor dtico é compativel com qualquer equipamento que possua
interface MADI. Alguns fabricantes de mixers digitais adotam interfaces
proprietarias que, embora ndo utilizem o protocolo MADI, sdo eletricamente
compativeis. Consulte a DSPRO para verificar a compatibilidade de outras marcas e
modelos.

Fibra Otica Redundante
(até 2km) DSnake MAD

DSnake MAD

-, o, i

I Bridge

I Bridge

Coaxial Coaxial

FOH Rack | Stage Rack

Figura14: Aplicacdo do DSnake MADI Bridge como conversor 6tico

Para habilitar o modo conversor 6tico via DSManager, selecione a opcdo Media Converter
para o parametro Mode na tela da Figura 10.
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5. DSNAKE COMPACT

O DSnake Compact é um gabinete com 8 slots para placas de I0 que vem equipado com
uma unidade central de processamento CPU e uma fonte de alimentagao.

O mddulo de CPU é a unidade de processamento digital de sinais responsavel pela
transferéncia do audio entre todos os equipamentos. Possui 2 interfaces digitais Ethernet em
conectores Neutrik® Ethercon® por onde o audio é transmitido digitalmente sob o protocolo
DSPRO.

As portas MAIN e BACKUP sdo as responsaveis por ligar de forma redundante todos os
equipamentos do caminho principal. Possuem um LED de Link/atividade que indica que o
sinal digital esta trafegando e um LED ACTIVE que indica quando uma porta esta recebendo
corretamente os dados poraquela interface.

VISTA FRONTAL
(@] ® @ O
%\a ke
D COMPACT l@ @ O

T dsore
DENAKE COMRACT
ALarMO
e}

b bo

Figura 15. DSnake Compact

1. Interface digital de Audio DSPRO - Interface digital de adudio em conector
RJ45 Ethercon®. As interfaces MAIN e BACKUP sdo usadas no link principal de forma
redundante, enquanto as interfaces Split 1 e Split 2 podem ser usadas para envio do
audio para mais destinos sem necessidade de switches extemos.

2. Chave RING/STACKING - Chave que seleciona o modo de funcionamento do

equipamento ente anel (stacked) ou estrela. No modo anel os equipamentos sao
conectados de maneira a formar um circulo, enquanto no modo estrela devem ser
conectados todos em paralelo, através de switches.

3. Chave ENABLE INPUTS - Chave que habilita os canais de entrada, enviando os

mesmos pela interface digital. E utilizado para desabilitar os canais em equipa mentos
que estdo sendo utilizados como split.
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4. Chave CHANNEL RANGE - Chave que seleciona o intervalo de canais sendo
utilizado pelas interfaces de dudio na rede. No modo LOW sdo utilizados os canais de
1 a 64 enquanto no modo HIGH sdo utilizados os canais de 65 a 80. Através do
software de geréncia é possivel ativar o modo avancado de patch, onde cada canal
tem seu caminho configurado de forma independente. Nesse c@so a chave perde sua
funcdo, o que é indicado pelos dois LEDs de range de canais acesos (veja o capitulo
8.4 - Janela Patchbay).

5. LEDs principais - Indicam as configuragGes do sistema:

e LED CLOCK MASTER indica que o relégio do equipamento estd sendo usado de
referéncia na rede.

e LED STACKED indica se o equipamento esta operando no modo anel ou modo estrela,
de acordo com a chave seletora (*2).

e LEDs 48/96k indicam a taxa de amostragem sendo usada, que deve ser a mesma em
todos os equipamentos da rede.

e LEDs LO e HI indicam quais os canais que as interfaces de audio desse equipamento
estdo utilizando no rede. Maiores detalhes no capitulo 8.4 - Janela Patchbay.

e LED ENABLE INPUTS indica se as entradas desse equipamento estdo sendo enviada
para a rede digital

e LED ALARM indica alguma falha grave.

6. Interface REMOTE RS-232 - Interface para geréncia através do PC, que
também pode ser feita por quaisquer das interfaces Ethernet.

7. Conectores de Saida de Audio - Oito saidas analdgicas balanceadas em nivel
de linha em conector DB25 do moédulo DSM-DA8C. Podem estar instaladas em
qualquer dos 8 slots de IO.

8. Conector de Entrada de Audio - Oito entradas analdgicas balanceadas em
nivel de linha em conector DB25 do mddulo DSM-AD8C. Podem estar instaladas em
qualquer dos 8 slots de I10.

9. Fusivel - Fusivel geral de protegéo.
10.Chave de Liga/ Desliga - Chave principal de energia do equipamento.

11.Conector de Entrada de Alimentacdao - Conector de entrada e alimentacdo
AC. Possui selecdo automatica de 90-250VAC.

12.LEDs do Moédulo de Alimentacao - O LED ON indica que o equipamento esta
ligado, enquanto o LED ALARM indica problemas na fonte de alimentagao.

5.1. Médulo de entrada AD8SC (DSM-ADS8C)

Figura 16 Médulo AD8C (DS M-ADSC)

Médulo com 8 saidas de linha em um Unico DB25 para DSnake Compact. Podem ser
inseridos até 8 desses modulos, de forma a deixar o DSnake com 64 canais de saida.
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Figura 17 Médulo DA8SC (DS M-DAS8C)

Médulo com 8 entradas de linha em um Unico DB25 para DSnake Compact. Podem ser
inseridos até 8 desses modulos, de forma a deixar o DSnake com 64 canais de entrada.
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6. INSTALAGAO

Os produtos da familia DSnake foram projetados para instalagdo em Rack de padrdao 19”.

O DSnake Modular ocupa 4 unidades de Rack em altura e devido a ventilagdo ter entradas e
saidas nas laterais do equipamento, o Rack deve prever espagos laterais minimos de 20mm,
e ainda ter a parte traseira aberta e desobstruida.

SAIDA TRASEIRA ABERTA

MINIMO MINIMO
20mm 20mm

Figura 18 Instalacéo no rack, vistasuperior DSnake Modular

O DSnake Compact ocupa apenas uma unidade de Rack mas também possui entrada e saida
de ventilagdo nas laterais, sendo necessarios os mesmos 20mm de espagamento lateral e
abertura traseira do rack

SAIDA TRASEIRA ABERTA

MINIMO MINIMO
20mm 20mm

Figura19 Instalacdo no rack, vistasuperior DSnake Compact
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Na impossibilidade de abertura da parte traseira do Rack recomenda-se que seja observado
um espagamento entre o equipamento e os seguintes, tanto na parte superior quanto da
inferior. Esse espaco deve serde no minimo 1 Unidade de Rack (44.45mm) e deve ser
aberto para passagem de ar e troca de calor.

MINIMO
44.45mm

MINIMO
44.45mm

MINIMO MINIMO
44.45mm 44.45mm

Figura 20 Instalagéo no rack, vista frontal
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7. OPERACAO BASICA (PLUG & PLAY)

7.1. Introducao

Nessa secdo serao abordados conceitos gerais do sistema DSnake. Se ja estiver familiarizado
avance para sua aplicagdo de interesse — segao 7.2 Multicabo digital e posteriores.

7.1.1. Modularidade

O DSnake Modular possui 5 slots de audio, sendo que cada um deles pode ser equipado com
placas de entrada, como a DSNAKE AD8-PRE, ou de saida, como a DSNAKE DAS.

Os slots sdo contados de cima para baixo, sendo o slot 1 o primeiro. As portas sdao contadas
da esquerda para a direita, com 8 portas por slot. Na Figura 21 temos um DSnake Modular
equipado com uma DSNAKE AD8-PRE no slot 1 e uma DSNAKE DAS8 no slot2:

Figura 21 Slots do DSnake Modular

O DSnake Compact possui 8 slots de audio, podendo ser equipado com placas de entrada,
como a DSNAKE ADS8C, ou de saida, como a DSNAKE DASC.

Os slots sao contados da esquerda para direita e de cima para baixo. Veja ANEXO I - DB25
para informacgdes sobre a disposicdo das portas no DSnake Compact. Na Figura 22 temos
um DSnake Compact equipado com placas de saida nos slots 1 e 2 e uma placa de entrada
no slot 5:

g ey p—p— = =lficocacooaooad '|'| =
e die and ralsg -D" 241 ooDDoDoODDo0 o F
B A, i Dy sttt =
|] } o T |

il P nununoununo
UsE CH 3340

Figura 22 Slots do DSnake Compact

7.1.2. Modo Transparente
A Figura 23 a seguir mostra trés equipamentos operando em modo transparente:

e DSnake Modular, placas DSNAKE AD8-PRE nos slots de 1 a 4 e DSNAKE DA8 no slot
5, chave CH RANGE na posicdo 1..40.
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e DSnake Compact, com placas DSNAKE ADS8C nos slots de 1 a 4 e DSNAKE DA8C no
slot 5, chave CH RANGE na posicao LO. Esse equipamento se conecta com a porta
Ethernet MAIN do DSnake Modular.

e DSnake Compact, com placas DSNAKE AD8C nos slots de 1 a 4, chave CH RANGE na
posicao LO. Esse equipamento se conecta com a porta Ethernet SPLIT1 do DSnake
Modular.

As portas SPLIT podem ser usadas para gravagao, geréncia ou split digital.

O equipamento recebe audio apenas a partir das portas MAIN e BACKUP, que tém também
as mesmas funcionalidades das portas SPLIT..

NN

Se um slot estiver equipado com uma placa de entrada de adudio, como a DSNAKE AD8-PRE,
estara realizando conversdo AD nos canais conectados. Da mesma forma uma placa DSNAKE
DAS8 realiza conversao DA.

CH1.8 @.@O@OOO h
CH9..16 ( &
CH17..24
CH 25..32 X ) - :
CH 33..40 —4— xoopueone — | e
: CH9..16 CH 25..32
y
CH1.8 CH17..24
/L Visao Traseira
{o — @@ -g-!»-!_-!j
o - © b e se— de— 3|

- S
B cio ks Dk o o J

CH9..16 CH 25..32
CH1.8 CH 17..24

T 8@, amEE=E=y

@ @ [w)
. ~
B4 o k
kg oD Znake | o OJ

CH 33..40

Visao Frontal

Figura 23. Modo de operacdo transparente

Os canais de audio 1..32 entram no DSnake Modular e sdo transmitidos para ambos DSnake
Compact (destaque em verde) nas mesmas posigdes - o canal de audio que entra no slot 1,
porta 1 do DSnake Modular sai na mesma posicdo (slot 1, porta 1) dos DSnake Compact.

Da mesma forma os canais 33..40 inseridos no slot 5 do DSnake Compact sdo transmitidos
para o slot 5 no DSnake Modular (destaque em azul).

No modo de operacao transparente os canais de audio inseridos em um slot e porta de um

equipamento na rede aparecem sempre nesse mesmo slot e porta nos equipamentos
remotos.

No DSnake Modular o modo transparente é identificado através dos LEDs CH 1..40 e CH
41..80, no DSnake Compact através dos LEDs CH RANGE LO e HI. Em ambos equipamentos
apenas 1 dos LEDs deve estar ligado para identificar esse modo.
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REMOTE
RE5-232

Figura 25. DSnake Modular, chawe e LEDs do Channel Range

Se ambos LEDs indicativos de channel range estiverem ligados o equipamento possui patch
habilitado (veja o capitulo 8.4 - Janela Patchbay).

No modo transparente os canais de audio sdo colocados em posicoes fixas na interface
Ethernet, podendo assumir os seguintes valores:

DSnake Modular

Slot 1 Slot 2 Slot 3 Slot 4 Slot 5

CH1..40 1a8 9al1l6 | 17a24| 25a 32| 33a40

CH41..80(41a48|49a56| 57a64| 65a72| 73a80

DSnake Compact
Slot 1 Slot 2 Slot 3 Slot 4 Slot 5 Slot 6 Slot 7 Slot 8

CH LO 1a8 9al1l6 | 17a24| 25a32| 33a40| 41 a48| 49a 56| 57 a64

CH HI 65a72|73a80 - - - - - -
Tabelal. Channel Range para DSnake Modular e Compact

7.1.3. Sample Rate

A taxa de amostragem do equipamento é configurdvel para 48kHz ou 96kHz, veja o capitulo
8.8 - Selecionando a Taxa de Amostragem.

A selegdo de canais acima de 40 s6 é possivel se o equipamento estiver operando com taxa
de amostragem de 48kHz. Se um equipamento operando a 96kHz for configurado para
canais acima de 40 os LEDs de channel range pisardo indicando configuracdo invalida e
todas entradas serao desabilitadas.
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7.2. Multicabo digital

Essa aplicagdo substitui um multicabo analdgico com capacidade de até 40 vias. Sdo usados
dois DSnake Modulares, permitindo transportar 32 canais em um sentido e 8 canais no
sentido oposto. Opcionalmente pode usar-se um cabo Ethemet secundario para atuar em
caso de falha no link principal.

cH1.8 » | OEEEOLE
CHO.16 P | f, .f; 'f
CH 27..24 b‘ ]" (
CH25.32 P — :
- 3
CH 33..40 -: 0O000OO 1.
DSnake Modular #1 ;
A B
A
IR
1
3
|
cH1.s < OOOOOOER =7 | 1 ik
= = B

cH9.16 <= QODODRER — &

CH27.24 -« DOODRROR, = I < 3
CH25.32 4 [@@@oo@u i S
CH 33.40 D) eee. - : A8 -

DSnake Modular #2

Figura 26. Multicabo digital
O sistema é composto da seguinte forma:

e DSnake Modular #1: 4 placas DSNAKE AD8-PRE nos slots de 1 a 4, uma plaa
DSNAKE DA8 no slot 5.

e DSnake Modular #2: 4 placas DSNAKE DAS8 nos slots de 1 a 4, uma placa DSNAKE
AD8-PRE no slot 5.

Serad usado o modo transparente (veja 7.1.2 Modo Transparente). Nesse modo os canais tém
relacdo direta: o sinal na entrada slot 1, porta 1 do equipamento #1 sai no slot 1, porta 1 do

equipamento #2 (CH1).
Passo a passo:

1. Conecte a alimentacdo nos equipamentos. Ligue a chave das fontes de alimentacdo.
O LED ON das fontes deve acender.

2. Conecte o abo Ethemet na porta MAIN de ambos equipamentos. O LED LINK da
porta MAIN de ambos equipamentos deve piscr indicando atividade.

[opcional] Conectar um segundo cabo Ethernet entre as portas BACKUP dos
equipamentos para protecdao em caso de falha da conexdo principal. O LED LINK da
porta BACKUP deve também piscar indicando atividade.

3. Configure as chaves do DSnake Modular e verifique os demais LEDs (Figura 27):
e Colocara chave CH_RANGE (Figura 27, legenda 1) na posigao 1..40.

e O LED CH1..40 deve estar ligado e o LED CH41..80 desligado (Figura 27, legenda 6).
Caso ambos LEDs, CH1..40 e CH41..80, estejam ligados sera necessario desabilitar o
patch através do DSManager, veja o capitulo 8.4 - Janela Patchbay.
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e Colocara chave STACKING (Figura 27, legenda 1) na posicao OFF.
e O LED STACKED (Figura 27, legenda 4: LED superior) deve estar desligado.

e O LED indicador de Sample Rate (Figura 27, legenda 5: 48kHz ou 96kHz) aceso deve
ser 0 mesmo em ambos equipamentos indicando que estdo operando com a mesma
taxa de amostragem. Caso os equipamentos estejam com taxas de amostragem
diferentes sera necessario reconfigurar um deles, veja o capitulo 8.8 - Selecionando
a Taxa de Amostragem.

e Em um dos equipamentos acende o LED CLK MSTR (Figura 27, legenda 4: LED

inferior).
Cl&E =
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Figura27. Chawes e LEDs DSnake Modular
4. [opcional] Usando o DSManager (veja o capitulo 8 - Utilizando o DSManager):
e Ajuste os ganhos dos canais de entrada.
e Habilite Phantom power conforme a necessidade.

O Multicabo Digital estéd configurado. Para testd-lo basta conectar uma fonte de dudio na
porta de entrada de um dos equipamentos e conectar a saida complementar ao sistema de
amplificacao (exemplo: AD8PRE: slot 2, porta 3 no equipamento#1 e DAS8: slot 2, porta 3 no
equipamento #2 (CH11).

7.3. Multicabo digital usando DSnake Compact

Essa aplicagdo substitui um multicabo analégico com capacidade de até 40 vias de forma
idéntica ao item anterior (veja 7.2 Multicabo digital), usando o DSnake Compact.

Sao usados, portanto, um DSnake Modular e um DSnake Compact, permitindo transportar
32 canais em um sentido e 8 canais no sentido oposto. Opcionalmente pode usar-se um cabo
Ethernet secundario para atuar em caso de falha no link principal.
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Figura 28. Multicabo digital Compact
O sistema é composto da seguinte forma:

e DSnake Modular : 4 placas DSNAKE AD8-PRE nos slots de 1 a 4, uma placa DSNAKE
DA8 no slot 5.

e DSnake Compact: 4 placas DSNAKE DASC nos slots de 1 a 4, uma placa DSNAKE
AD8C no slot 5.

Sera usado o modo transparente (veja 7.1.2 Modo Transparente). Nesse modo os canais tém
relagdo direta: o sinal na entrada slot 1, porta 1 do DSnake Modular sai no slot 1, porta 1 do

DSnake Compact (CH1).
Passo a passo:

1. Conecte a alimentacdo nos equipamentos (a entrada de alimentacdo do DSnake
Compact fica no painel traseiro). Ligue a chave das fontes de alimentagdo. O LED ON

das fontes deve acender.

2. Conecte o cabo Ethemet na porta MAIN de ambos equipamentos. O LED LINK da
porta MAIN de ambos equipamentos deve piscar indicando atividade.

[opcional] Conectar um segundo cabo Ethernet entre as portas BACKUP dos
equipamentos para protecdo em caso de falha da conexdo principal. O LED LINK da
porta BACKUP deve também piscar indicando atividade.

3. Configure as chaves do DSnake Modular e verifique os demais LEDs (Figura 29):

JENAKE CPU

Figura29. Chaws e LEDs DSnake Modular
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6.

Colocara chave CH_RANGE (Figura 29, legenda 1) na posigao 1..40.

O LED CH1..40 deve estar ligado e o LED CH41..80 desligado (Figura 29, legenda 6).
Caso ambos LEDs, CH1..40 e CH41..80, estejam ligados sera necessario desabilitar o
patch através do DSManager, veja o capitulo 8.4 - Janela Patchbay.

Colocara chave STACKING (Figura 29, legenda 2) na posigdo OFF.
O LED STACKED (Figura 29, legenda 4: LED superior) deve estar desligado.

Configure as chaves do DSnake Compact e verifique os demais LEDs (Figura 30):

REMOTE

R5-232 '
i =i
e I

Co

1 11T
123 4567

Figura 30. Chawes e LEDs DSnake Compact
Colocara chave CH_RANGE (Figura 30, legenda 3) na posigao LO.

O LED CH RANGE LO deve estar ligado e o LED CH RANGE HI desligado (Figura 30,
legenda 6). Caso ambos LEDs, CH RANGE LO e CH RANGE HI, estejam ligados sera
necessaria configuracdo de patch através do DSManager, veja o capitulo 8.4 - Janela
Patchbay.

Colocar a chave RING/STACKING (Figura 30, legenda 1) na posicao OFF.
O LED STACKED (0, legenda 4: LED superior) deve estar desligado.
Colocar a chave ENABLE INPUTS (Figura 30, legenda 2) na posigao ON.

O LED indicador de entradas habilitadas ENABLE INPUTS (Figura 30, legenda 4: LED
inferior) deve estar ligado.

Verificar em ambos equipamentos:

O LED indicador de taxa de amostragem (48kHz ou 96kHz: Figura 29, legenda 5 para
o0 DSnake Modular e, Figura 30 legenda 5 para o DSnake Compact) aceso deve ser
idéntico. Caso os equipamentos estejam com taxas de amostragem diferentes sera
necessario reconfigurar um deles, veja o capitulo 8.8 - Selecionando a Taxa de
Amostragem.

Em um dos equipamentos acende o LED CLK MSTR (Figura 29, legenda 4 para o
DSnake Modular e, Figura 30 legenda 4 para o DSnake Compact - LED inferior).

[opcional] Usando o DSManager (veja o capitulo 8 - Utilizando o DSManager):
Ajuste os ganhos dos canais de entrada do DSnake Modular.

Habilite Phantom power conforme a necessidade.

O Multicabo Digital estd configurado. Para testd-lo basta conectar uma fonte de audio na
porta de entrada de um dos equipamentos e conectar a saida complementar ao sistema de
amplificacdo (exemplo: DSnake Compact ADS8C: slot 5, porta 1 e DSnake Modular DAS8: slot
5, porta 1 (CH33).
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7.4. Multicabo digital com split

Essa aplicacdo usa um DSnake Modular e um DSnake Compact, configurados como um
multicabo digital e um DSnake Compact adicional realizando o split.

Todos os canais disponiveis na rede sdo convertidos novamente em sinais analdgicos no
equipamento de split, como mostra a Figura 31:
CH9..16 CH 25..32
CH1.8 A CH17.24 A
A A
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Figura 31. Multicabo digital comsplit

Equipamentos:

e DSnake Modular : 4 placas DSNAKE AD8-PRE nos slots de 1 a 4, uma placa DSNAKE
DA8 no slot 5.

e DSnake Compact #1: 4 placas DSNAKE DA8C nos slots de 1 a 4, uma placa DSNAKE
ADS8C no slot 5.

e DSnake Compact #2:5 placas DSNAKE DA8C nos slotsde 1 a 5.

Sera usado o modo transparente (veja 7.1.2 Modo Transparente). Nesse modo os canais tém

relacdo direta: o sinal na entrada slot 1, porta 1 do DSnake Modular sai no slot 1, porta 1 do
DSnake Compact #1 e DSnake Compact#2 (CH1).

As placas de entrada ou saida nos equipamentos podem variar. O importante no modo
transparente é que haja somente uma placa de entrada em um determinado slot e channei
range globalmente no sistema.

Nessa aplicagdo todos equipamentos estdo usando channel range baixo (canais 1..40 no
DSnake Modular e canais 1..65 nos DSnake Compact).

Os slots de 1 a 4, por exemplo, entram no DSnake Modular enquanto o slot 5 entra no
DSnake Compact #1: nos demais equipamentos temos placas de saida nessas posigdes.
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Passo a passo:

1.

Conecte a alimentacdo nos equipamentos (a entrada de alimentacdo nos DSnake
Compact fica no painel traseiro). Ligue a chave das fontes de alimentacdao. O LED ON
das fontes deve acender.

Conecte o cabo Ethernet nas portas MAIN do DSnake Modular e DSnake Compact

#1. O LED LINK da porta MAIN de ambos equipamentos deve piscar indicando
atividade.

[opcional] Conectar um segundo @abo Ethemet entre as portas BACKUP do DSnake
Modular e DSnake Compact #1 para protecdo em caso de falha da conexao principal.
O LED LINK da porta BACKUP deve também piscar indicando atividade.

Conecte o cabo Ethemet na portas SPLIT1 do DSnake Modular e porta MAIN do

DSnake Compact #2. O LED LINK de ambas portas Ethernet deve piscar indicando
atividade.

Configure as chaves do DSnake Modular e verifique os demais LEDs (Figura 32):

JENAKE CPU
e R

R

Figura 32. Chawes e LEDs DSnake Modular
Colocar a chave CH_RANGE (Figura 32, legenda 1) na posicao 1..40.

O LED CH1..40 deve estar ligado e o LED CH41..80 desligado (Figura 32, legenda 6).
Caso ambos LEDs, CH1..40 e CH41..80, estejam ligados serd necessario desabilitar o
patch através do DSManager, veja o capitulo 8.4 - Janela Patchbay.

Colocar a chave STACKING (Figura 32, legenda 2) na posigao OFF.
O LED STACKED (Figura 32, legenda 4: LED superior) deve estar desligado.

Verifique as configuragdes das chaves e LEDs nos DSnake Compact (Figura 33):

REMOTE
R5-232 '
foosaf

co

1 111
1 23 4567

Figura33. Chaves e LEDs DSnake Compact
Colocar a chave CH_RANGE (Figura 33, legenda 3) na posigao LO.

O LED CH RANGE LO deve estar ligado e o LED CH RANGE HI desligado (Figura 33,
legenda 6). Caso ambos LEDs, CH RANGE LO e CH RANGE HI, estejam ligados sera

necessario desabilitar o patch através do DSManager, veja o apitulo 8.4 - Janela
Patchbay.

Colocar a chave RING/STACKING (Figura 33, legenda 1) na posicao OFF.
O LED STACKED (Figura 33, legenda 4: LED superior) deve estar desligado.
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e DSnake Compact #1: Coloar a chave ENABLE INPUTS (Figura 33, legenda 2) na
posicdo ON.

A configuracdo de ENABLE INPUTS é indiferente no DSnake Compact #2 pois ndo ha
slots de entrada instalados.

O LED indicador de entradas habilitadas ENABLE INPUTS (Figura 33, legenda 4: LED
inferior) deve estar ligado.

6. Verifique em todos equipamentos:

O LED indicador de Sample Rate (SMPL RATE: 48k / 96k no DSnake Compact ou LED
48kHz / 96kHz no DSnake Modular ) aceso deve ser o mesmo nos trés
equipamentos indicando que todos estdo operando com a mesma taxa de
amostragem. Caso os equipamentos estejam com taxas de amostragem diferentes
serd necessario reconfigurd-los (veja o capitulo 8.8 - Selecionando a Taxa de
Amostragem).

Em um dos equipamentos acende o LED CLK MSTR (Figura 32, legenda 4 para o
DSnake Modular e,Figura 33 legenda 4 para o DSnake Compact - LED inferior).

7. [opcional] Usando o DSManager (veja o capitulo 8 - Utilizando o DSManager):
e Ajuste os ganhos dos canais de entrada do DSnake Modular.
e Habilite Phantom power conforme a necessidade.

O Multicabo Digital estd configurado. Para testa-lo basta conectar uma fonte de audio na
porta de entrada de um dos equipamentos e conectar a saida complementar ao sistema de
amplificacdo (exemplo: DSnake Compact #2 ADS8C: slot 5, porta 2 e DSnake Compact #1
DAS8C: slot 5, porta 2 (CH34).

7.5. Distribuicao de audio em anel

Na topologia a seguir os equipamentos s3ao conectados em sequéncia, por simplicidade
adotamos a conexao da porta BACKUP de um equipamento com a porta MAIN do
equipamento seguinte.

O resultado final é uma rede de distribuicdo completa onde o audio recebido em um
equipamento pode ser retirado em qualquer ponto remoto.

Outra caracteristica do sistema em anel é a protecdo em caso de falha, sendo robusto a
qualquer falha simples (interrupgdo de uma conexdo Ethemet individualmente) sem que o
audio se interrompa. Isso é possivel pois a comunicagdo no anel é bidirecional, operando nos
sentidos hordrio, mostrado na Figura 34, e anti-horario suprimido por simplicidade.
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Figura 34. Distribuicdo de audio em anel

Equipamentos:

DSnake Modular #1 : 5 placas DSNAKE AD8-PRE nos slots de 1 a 5, uma placa

DSNAKE DA8 no slot 5.
DSnake Modular #2 : 3 placas DSNAKE AD8-PRE nos slots de 1 a 3, uma plaa

DSNAKE DAS8 nos slots 4 e 5.
DSnake Compact #1: 8 placas DSNAKE DA8C nos slotsde 1 a 8.

DSnake Compact #2: uma placa DSNAKE ADS8C no slot 1, uma placa DSNAKE DASC

no slot 2.

DSnake Compact #3: 8 placas DSNAKE DA8C nos slotsde 1 a 8.

DSnake Compact #4: uma placa DSNAKE DA8C no slot 1, uma placa DSNAKE AD8C

no slot 2.

Sera usado o modo transparente (veja 7.1.2 Modo Transparente). Nesse modo os canais tém
relagdo direta: o sinal na entrada slot 1, porta 1 do DSnake Modular #1 sai no slot 1, porta 1
dos DSnake Compact #1 e DSnake Compact #3 (CH1).
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As placas de entrada ou saida nos equipamentos podem variar. O importante no modo
transparente é que haja somente uma placa de entrada em um determinado slot e channe
range globalmente no sistema.

No caso dos DSnake Modular #1 e #2 ndo ha conflito pois apesar dos slots de 1 a 3 estarem
equipados com placas DSNAKE AD8PRE em ambos equipamentos o DSnake Modular #1 sera
configurado para operar nos canais de 1 a 40 (chave CH RANGE na posicao CH1..40) e o
DSnake Modular #2 serd configurado para operar nos canais de 41 a 80 (chave CH RANGE
na posicao CH41..80).

Os DSnake Modular sdo capazes de enderecar 40 canais por possuirem 5 slots de 8 portas
enquanto os DSnake Compact tém capacidade para até 64 canais em 8 slots de 8 portas.

Passo a passo:

1. Conecte a alimentacdo nos equipamentos (a entrada de alimentagdo nos DSnake
Compact fica no painel traseiro). Ligue a chave das fontes de alimentacdao. O LED ON
das fontes deve acender.

2. Conecte os abos Ethernet conforme a Figura 34. Em resumo corresponde a conectar
0s equipamentos formando um anel, sempre com a porta BACKUP contra a porta
MAIN do proximo elemento. Os LEDs LINK das portas MAIN e BACKUP dos
equipamentos devem comegar a piscar indicando atividade.

3. Configure as chaves do DSnake Modular e verifigue os demais LEDs (Figura 35):

JENAKE CPU

Figura35. Chawes e LEDs DSnake Modular

e DSnake Modular #1: Colocar a chave CH_RANGE (Figura 35, legenda 3) na posicado
CH 1..40.

O LED CH 1..40 deve estar ligado e o LED CH 41..80 desligado (Figura 35, legenda
6).

e DSnake Modular #2: Colocar a chave CH_RANGE (Figura 35, legenda 3) na posicédo
CH 41..80.

O LED CH 41..80 deve estar ligado e o LED CH 1..40 desligado (Figura 35, legenda
6).

Caso ambos LEDs, CH 1..40 e CH 41..80, estejam ligados nho mesmo equipamento
sera necessario desabilitar o patch através do DSManager, veja o capitulo 8.4 -
Janela Patchbay.

e Colocara chave STACKING (Figura 35, legenda 2) na posicdao ON.
e O LED STACKED (Figura 35, legenda 4: LED superior) deve estar ligado.

4. Verifique as configuragbes das chaves e LEDs nos DSnake Compact (Figura 36):
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Figura36. Chawes e LEDs DSnake Compact

DSnake Compact #1 e #3:

o Colocar a chave CH_RANGE (Figura 36, legenda 3) na posigao LO. O LED CH
LO deve estar ligado e o LED CH HI desligado (Figura 36, legenda 6).

o A posicdo da chave ENABLE INPUTS (Figura 36, legenda 2) é indiferente ja
que esses equipamentos ndo possuem placas de entrada.

DSnake Compact #2 e #4:

o Colocar a chave CH_RANGE (Figura 36, legenda 3) na posicao HI. O LED CH
HI deve estar ligado e o LED CH LO desligado (Figura 36, legenda 6).

o Colocar a chave ENABLE INPUTS (Figura 36, legenda 2) na posicao ON. O
LED ENABLE INPUTS (Figura 36, legenda 7 - LED inferior) deve estar ligado
nesses equipamentos.

Caso ambos LEDs, CH RANGE LO e CH RANGE HI, estejam ligados no mesmo
equipamento serd necessario desabilitar o patch através do DSManager, veja o
capitulo 8.4 - Janela Patchbay.

Colocar a chave RING/STACKING (Figura 36, legenda 2) na posicdo ON.
O LED STACKED (Figura 36, legenda 4: LED superior) deve estar ligado.
Verifique em todos equipamentos:

O LED indicador de Sample Rate (SMPL RATE: 48k / 96k no DSnake Compact (Figura
36, legenda 5) ou LED 48kHz / 96kHz no DSnake Modular (Figura 35, legenda 5))
aceso deve ser o mesmo em todos equipamentos, indiando que todos estdo
operando com a mesma taxa de amostragem.

Caso haja equipamentos com taxas de amostragem diferentes serd necessario
reconfigura-los através do DSManager (veja o capitulo 8.8 - Selecionando a Taxa de
Amostragem).

Em um dos equipamentos acende o LED CLK MSTR (Figura 35, legenda 4 para o
DSnake Modular e Figura 36, legenda 4 para o DSnake Compact - LED inferior).

[opcional] Usando o DSManager (veja o capitulo 8 - Utilizando o DSManager):
Ajuste os ganhos dos anais de entrada do DSnake Modular.

Habilite Phantom power conforme a necessidade.

O sistema de distribuicdo de audio em anel esta configurado. Para testa-lo basta conectar uma fonte de
audio na porta de entrada de um dos equipamentos e conectar a saida complementar ao sistema de
amplificagdo: DSnake Compact #2 AD8C: slot 5, porta 2 e DSnake Compact #1 DA8C: slot 5, porta 2

(CH34).
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8. UTILIZANDO O DSMANAGER

8.1. Instalacao

A instalacdo do DSManager é feita a partir de um arquivo executavel chamado DSManager-
X.YZ-setup.exe, onde X.YZ representa a versdao do DSManager. Com um duplo clique no
arquivo inicia-se a instalacdo. Possivelmente serd enviado um aviso do sistema operacional
sobre a execucgdo do instalador. Permita, conforme a figura abaixo. Os botbes padrdao para a
instalagdo do DSManager estdao destacados em vermelho nas figuras desta segdo.

r 4

Controle de Conta de Usudrio @

l@ Um programa ndo identificado deseja ter acesso ao seu computador

W&o execute o programa, a menos que conhega sua origem ou j o tenha utilizado antes,

H | DSManager-1.00-setup.exe
Editor Nae Identificade

< Cancelar
Nao sei qual a origem ou a finalidade deste programa.

< Permitir

Confie neste programa porque conhego sua origem ou ja o utilizei antes,

\:' Detalhes

0 Controle de Conta de Usudrie ajuda a proibir alteragdes nde auterizadas em seu computador,

Figura 37. Aviso do Sistema Operacional sobre a execugéo do instalador

ApOs o inicio de sua execugdo, o instalador busca por alguma versdo ja instalada do
DSManager. Caso nao exista, a instalacdo segue normalmente. Havendo outra versao no
computador, é exibida uma mensagem explicativa e aguarda-se a decisdo para prosseguir
com a instalagdo ou manter a cépia antiga. No exemplo da figura acima, uma versdo
anterior foi encontrada. Clique em "Sim” se deseja instalar um novo DSManager e apagar a
versdo que vocé possui instalada. Caso contrario, clique em "Ngo”.

DSManager version 1,00 Installer 24

D5Manager version 0.94 is installed on your systern. Do you wish to upgrade to
DSManager version 1.007

| sim || N

Figura 38. Aviso sobre outra versdo do DS Manager encontrada no computador

No menu principal do instalador (Figura 39), é possivel escolher onde serdo criados atalhos
para o DSManager: desktop e/ou menu Iniciar. A opgao padrdo € a criacdo de todos atalhos.
Marque as opgdes desejadas e clique em "Next”.
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FE DSManager version 1.00 Installer E' = @“

— -

Chedk the components you want to install and uncheck the components you don't want to
install. Click Mext to continue.
Select components to install: DSManager (Required)

Start Menu Shortcuts

Desktop Shortout
Space required: 19.0MB

[ Mext = ] [ Cancel

Figura 39. Menu principal doinstalador

No passo seguinte, é definido o diretério de instalacio do DSManager (Figura 40). Caso
deseje modificar a opgdo padrdo, digite o caminho até o diretdrio de instalagdo desejado ou
cligue em "Browse” e escolha o diretério. Para prosseguir a instalagdo, clique em “Install”.

B2 psManager version 1,00 Installer == |[&3]
=X
-

Setup will install DSManager in the following folder. To install in a different folder, dick Browse
and select another folder, Click Install to start the installation.

Destination Folder

C:\Program Files\DSPRO\DSManager

Space required: 19.0MB
Space available: 9.9GB

[ < Back ][ Install ]|[ Cancel

Figura 40. Janela de escolha do diretério de instalagédo

Para que a instalacdo do DSManager seja concluida com sucesso, dois softwares devem estar
instalados no computador: Java Runtime Environment (versdo minima: 1.5) e WinPcap
(versdo minima: 3.1). Caso ndo sejam encontrados, um aviso como o da Figura 41 serd
exibido. Selecione a opgdo "Sim” Para instalar o software. Ndo é necessario alterar qualquer
configuracdo na instalagdo dos softwares. A opcdo "Ndo” impossibilitard o DSManager de
rodar devidamente, sendo que a instalagdo termina com falha.
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EDSManagerversion 1.00 Installer [= = | ==

JRE not found

E DSManager version 1.00 Installer 3

In order to install D5SManager, Java Runtime Environment (JRE) version 1.5 or
greater is required,

D you wish to install JRE version 1.6 now?

(T continue D5Manager installaticn, choose 'Yes' option)

Figura4l. Aviso de software necessério para ainstalacdo do DS Manager

Caso seja detectada uma versdo instalada de algum desses softwares mais antiga do que a
disponibilizada com o DSManager, a atualizagdo é possivel. Um aviso semelhante ao da
Figura 41 sera exibido. Selecione "Sim” para instalar a versdo mais recente, e "Ndo” para
prosseguir com a instalagdo do DSManager. Este processo ndo é necessario.

Assim que todos arquivos forem copiados, a janela de progresso recebera o status
Completed, conforme a Figura 42. Clique em "Next” e surgird uma tela informando que o
processo de instalagao terminou com sucesso (Figura 43).

E DSManager version 1.00 Installer E' = | 22

Completed

Figura42. Instalagdo completa

Desmarque a opgao "Launch DSManager” caso ndo deseje que o DSManager seja executado
assim que a instalacdo terminar. Para finalizar, clique em "Close”.
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ED’SManagerversionl.UUInstaIIer [=] =] =

DSManager has been successfully
installed in your system.

| Launch DSManager

Figura43. Tela final dainstalag&o

Se todos passos foram seguidos corretamente, o DSManager ja esta pronto para ser iniciado.
O arquivo executavel do instalador ndo é necessario para rodar o DSManager.

8.2. Iniciando o DSManager

Para executar o DSManager é necessario que o computador esteja conectado a pelo menos

um equipamento da série DSnake. A conexdo pode ser feita via porta serial RS-232 ou
Ethernet.

8.2.1. Conexao via porta serial RS-232

Para geréncia via RS-232, conecte a porta REMOTE/RS-232 do DSnake Modular ou DSnake
Compact a porta serial do computador utilizando cabo DBOM/DB9F.

Se seu computador ndo possui porta serial RS-232, sera necessario utilizar um adaptador
USB - Serial.

Na inicializacdo do DSManager, selecione a opgao “COM Port” (Figura 44) e clique "OK”. A

partir desse momento, o DSManager detectara automaticamente todos os equipamentos
conectados.

B3 DSNAKE Network Discover = B )

Choose the connection port:

") Ethernet Port

Figura44. Selecionando conexao via portaserial
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8.2.2. Conexao via porta Ethernet

Para geréncia via porta Ethemet, é necessdrio que sejam feitos alguns ajustes nas
configuragbes IP do computador.

1. Inicialmente abra o Painel de Controle do Windows, utilizando o menu Iniciar ->
Painel de Controle

2. Selecione "Centro de Rede e Compartilhamento” (Windows Vista) ou “Conexdes de
Rede” (Windows XP) ou “Rede e Internet” e depois “Central de Redes e
Compartilhamento” (Windows 7).

3. Se estiver utilizando Windows XP pule este passo. Caso contrario, selecione

“Gerenciar Conexdes de Rede” (Windows Vista) ou "“Alterar configuracbes do
adaptador” (Windows 7).

4. Selecione a interface de rede que serd utilizada para conectar ao DSnake, clique com
o botdo direito e escolha “Propriedades”.

5. Eswlha a opgdo "“Protocolo TCP/IP (TCP/IP)” (Windows XP) ou "“Protocolo TCP/IP
Versdo 4 (TCP/IPv4)” (Windows Vista/7) e clique “Propriedades”.

fi Propriedades de Local Area Connection @

Rede | Compartihamento

Conectarse usando:

L¥ Reattek RTLB168C(F)/8111C(P) Family PCI-E Gigabit Eth

Esta conexdo utiliza os sequintes itens:

[ -a Protocolo TCP/IP versdo 6 (TCP/IPvE) -

B Protocolo TCP/IP Versdo 4 (TCP/IPvd)

& Driver de E/S do Mapeador de Descoberta de Tnpnlogl—l
-&. Respondente de Descoberta de Topologia de Camada ™

1| 1] 3
Descriggo

Transmigsion Control Protocol/iIntemet Protocol. Protocola
padrdo de rede de longa distancia que possibilta a
comunicagdo entre diversas redes interconectadas.

l 0K ” Cancelar ]

Figura 45. Selecéo do protocolo TCP/IP v4
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6. Marque a opgao “Usar o seguinte endereco IP:” e preencha os campos conforme a
Figura 46.

Propriedades de Protocolo TCP/IP Versdo 4 (TCP/IPv4) (2 ==

Geral

As configuracdes IP podem ser atribuidas automaticamente se a rede
oferecer suporte a esse recurso. Caso contrario, vocé precisa solicitar
a0 administrador de rede as configuracdes IP adequadas.

(*) Obter um endereco IP automaticamente

(@) Usar o seguinte enderego IP:
Endereco IP: 26782076 .73 X
Méscara de subrede: 255.255. 0 . 0

Gateway padrdo:

(@) Usar os seguintes enderegos de servidor DNS:
Servidor DNS preferencial:

Servidor DNS alternativo:

[ OK ][ Cancelar ]

Figura46. Configuracdo de enderego IP

Apos concluidas as configuragdbes de IP, inicie o DSManager e na tela inicial selecione
“"Ethernet Port” (Figura 47). A partir desse momento, o DSManager detectara
automaticamente todos os equipamentos conectados.

B DSNAKE Network Discover =sn =<

Choose the connection port:

(7) COM Port

Figura47. Selecionando conex&o via porta Ethernet

8.3. Janela Channel

Na janela Channel sao mostrados todos os canais de entrada do sistema. Nela estdo
disponiveis todos os controles dos pré-amplificadores e os medidores de nivel de sinal. Para
acessar a janela Channel clique no botao "Channel” na barra superior do DSManager (figura
49).

1000.0003.0002 Manual do Usuario — DSnake 41



AD3SPRE - Slot 4

e & & & PAD

2 © 9 +a8v
MUTE

) e LINK

23 26 27 28 29 30 321 32 MAP

crizfcnzfcnafcnalcnalcrzlcrzlcrzInAME]

Figura48. Visualizagéo dos canais de entrada.
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Figura49. Janela Channel
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Os canais de entrada sdo agrupados por slots. Cada grupo de oito canais representa um slot
de um equipamento, conforme a figura 48.

1.

Medidor de nivel - Fornece uma indicagdo visual do nivel do sinal de entrada. A

escala é graduada em decibel full scale (dBFS), conforme a Figura 51. Para garantir
uma boa conversdo analdgico-digital, € recomendado que o nivel do sinal de entrada

fique na regido amarela do medidor.

B 0dBFS (Clip)

-3dBFS

-6dBF S

-9dBFS

-12dBFS
-15dBFS
-18dBFS
-21dBFS
-24dBF35
-30dBFS
-J6dBFS
-42dBF3
-60dBFS

Figura51. Escala do medidor de nivel

Funcao Peak Hold

A fungdo peak hold faz com que as indicagdes
dos niveis maximos de sinal detectados as
entradas figuem ligadas até que o usuario as
limpe manualmente.

Para habilitar o peak hold, clique no botdo
"Peak Hold” na barra superior do DSManager.
Para limpar as indicagdes de pico, utilize o
botdo "Clear”. Cliqgue novamente no botdo
"Peak Hold” para desabilitar a funcdo (Figura
50).

A indicacdo de clip deve ser sempre limpa
manualmente, independente do peak hold
estar habilitado ou ndo. Para limpa-la utilize o
botdo “Clip Clear” na barra superior do
DSManager.

As indicacdo de pico e clip sao limpas
automaticamente quando o ganho do canal é
modificado.

=)

e
“Shake ADSPRE- slot4

Figura50. Funcéo peak hold

2. Ajuste de ganho - Esse botdo permite configurar o ganho analdgico dos pré-
amplificadores do mdédulo ADS8PRE numa faixa de 0 a 55dB, em passos de 1dB. O
ganho é aplicado antes da conversdo analdgico-digital (A/D). Para garantir uma
conversdo transparente e livre de ruidos é recomendado ajustar o ganho até que o
nivel do sinal de entrada fique na regido amarela do medidor (acima de -18dBFS).

3.

1000

ganho das entradas analdgicas.
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4. Botao Pad - Indica o estado atual do atenuador de entrada (pad). O pad é

acionado automaticamente quando o ganho é inferior a 30dB ou manualmente
através desse botdo.

5. Botao +48V - Permite habilitar o phantom power de forma independente por

canal, fornecendo alimentacdo de +48V para microfones capacitivos e Direct-boxes
ativas.

6. Botao Mute - Quanto ativo, esse botdo faz com que o canal fique mudo.

7. Botao Link - Permite encadear o controle de dois ou mais canais, fazendo com
que compartilhem a mesma configuracdo de ganho e pad. Quando o botdo l/ink de
um canal estiver ligado, seu ganho serd copiado do canal anterior. Os controles de
mute e phantom power nao sao afetados pelo link, sendo sempre independentes. A
Figura 52 exemplifica 0 encadeamento dos quatro primeiros canais.

20 21 22 23 24 MAP

Cralcrafcmlcralonalcnzlcrzlorzname

Figura52. Funcéo link

8. Mapeamento de entrada - Indica para qual canal da rede (1 a 80) o canal de

entrada estd mapeado. Se esse campo contiver *—", entdo o audio desse canal ndo
sera transmitido para a rede. Para modificar o mapeamento de um canal de entrada,
consulte o capitulo 8.4 - Janela Patchbay deste manual.

9. Nome do canal - Esse campo permite visualizar e editar os nomes dos canais de

entrada. Para edicdo de nome, clique sobre o campo “Name” do canal desejado e
digite 0 novo nome (Figura 53). Deixe o mouse parado sobre o campo “Name” do
canal para visualizar o nome completo (Figura 54).

1000.0003.0002 Manual do Usuario — DSnake



PAD
+ 4BV
MUTE
LINK
MAP

Input

6 Channal Names:

v 4 . Cancel

Figura53. Clique paraeditar o nome do canal

[=]

+48V
MUTE
LIMEK

— — -— MAP

crafcrafcrtferaferalcralcralcrainamE]

Piano L

Figura 54. Deixe 0 mouse parado para visualizar o nome do canal

8.4. Janela Patchbay

O patchbay é a funcionalidade do DSnake que permite direcionar qualquer entrada para
qualquer saida do sistema.

Para acessar a janela de visualizacdo e configuracdao de patchbay lique no botdo "Patch” da
barra superior do DSManager (Figura 55).
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DSNAKE Network Management
File Edit Tools Help

Channel E  patch (Equipments ) [ Recorder ] Mute All 1[ Peak Hold H Clip Clear 1

INPUT PATCH
OUTPUT PATCH
LOCAL PATCH

Channel 1

Channel 2
Channel 4
Channel 5
Channel 6
< | Channel 7
Channel 8

:

.

SLOT 2

n
8
g
S
=

=
£

H
=
@
a

DSPRE

SLOT3

ADSPRE

1t

pSPRO DSNAKE Fonnected 3 Equipment(s)

Figura55. Janela Patchbay

O patchbay do DSManager esta dividido em trés modulos:

1. Patchbay de entrada (Input Patch), que configura os mapeamentos das
entradas para a rede;

2. Patchbay de saida (Output Patch), que configura os mapeamentos da rede
para os canais de saida;

3. Patchbay local (Local Patch), que faz conexdes entre entradas e saidas de um
mesmo equipamento, sem utilizar a rede.

INPUT PATCH
OUTPUT PATCH

LOCAL PATCH

DSnake Modula. ..

03 Snare Bott..
04 Floor Tom

02 Snare Top
05 Tom 3
06 Tom 2
07 Tom 1
08 Hi Hat

o1 Kkick |

— EMABLE ?

ADSPRE - SLOT 1

Figura56. Habilitacdo do patchbay

Para habilitar ou desabilitar o patchbay, clique no nome do equipamento, que aparece a
esquerda na janela. Ao posicionar o mouse sobre o nome, o texto € substituido por
“ENABLE?" (habilitar) ou “"DISABLE?" (desabilitar), conforme a figura 56.
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Quando o patchbay esta desabilitado, o mapeamento do audio para a rede é definido
exclusivamente pelas posicdes que os mddulos de entrada e saida ocupam nos slots dos
equipamentos e pela posicdo da chave CH RANGE (veja o capitulo 7.1.2 - Modo
Transparente).

8.4.1. Patchbay de Entrada (Input Patch)

O patchbay de entrada (Input Patch) é usado para configurar em qual canal da rede um
determinado canal de entrada sera transmitido (Figura 57).

[+
R O Netwark Maragement [l
File Edt Tocls Help

|l 2T | ]

Figura57: Patchbay de entrada

A tela de configuragdo do patchbay de entrada possuios seguintes elementos:

1.
2.

Botao Input Patch - Clique nesse botdo para exibir o patchbay de entrada

Canais da rede - Na parte superior da janela sdao exibidos os nimeros e os nomes
dos canais da rede. Os nomes sao copiados automaticamente dos canais de entrada
mapeados. O DSnake disponibiliza 80 canais de rede quando operando a 48kHz ou
40 canais a 96kHz.

Nome do equipamento - Exibe o nome do equipamento, conforme configurado
na Janela Equipments. Clicando sobre o nome é possivel habilitar ou desabilitar o
patchbay do respectivo equipamento.

Identificagcdao do slot - Mostra 0 modelo e o nimero do slot de cada moédulo de
entrada dos equipamentos.

Identificagdao do canal de entrada - Mostra o nimero e o nome de cada canal
de entrada. Os nomes podem ser configurados na janela Channel do DSManager.

Mapeamento ativo - Os quadrados de cor azul escura indicam os mapeamentos
que estdo ativos no equipamento.
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7. Mapeamento padrao - Indicado pelos quadrados de cor azul clara, o
mapeamento padrdo corresponde as entradas que serdo atribuidas aos canais da
rede caso o0 patchbay seja desabilitado.

-
H
-4
.
T
3
n

SLOT 3

06 Snare Top
08 Ower L

Figura58. Configurando o patchbay: clique o com botao es querdo
para mapear oucom o direito para desmapear.

ADEPRE

Para fazer com que o audio de um canal de entrada seja transmitido para a rede, clique com
o0 botdo esquerdo do mouse no quadrado localizado na interseccao do canal de entrada
(linha) e do canal de rede desejado (coluna). Ao fazer isso, o canal da rede receberd
automaticamente o nome do canal de entrada (Figura 58). Para configurar os nomes dos
canais, utilize a janela Channel do DSManager.

O procedimento para desmapear um canal é analogo ao de mapeamento, exceto pelo fato de
que devera ser utilizado o botdo direito do mouse.
8.4.2. Patchbay de Saida (Output Patch)

O patchbay de saida (Output Patch) tem a finalidade de mapear canais de audio recebidos da
rede para as saidas do sistema. Os elementos da tela de configuracdo estdo indicados na
Figura 59:
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Figura59. Patchbay de saida

1. Botdo Output Patch - Clique nesse botdo para exibir o patchbay de saida;

2. Canais da rede - Na parte superior da janela sdo exibidos os nimeros e os nomes

dos canais da rede. Os nomes dos canais de rede sdo atribuidos pelo patchbay de
entrada (Input Patch). O DSnake disponibiliza 80 canais de rede quando operando a
48kHz ou 40 canais a 96kHz;

3. Nome do equipamento - Exibe o nome do equipamento, conforme configurado

na Janela Equipments. Clicando sobre o nome é possivel habilitar ou desabilitar o
patchbay do respectivo equipamento;

4. Identificagdao do slot - Mostra 0 modelo e 0 niimero do slot de cada mddulo de
entrada do dos equipamentos;

5. Identificacdao do canal de saida - Mostra os nimeros dos canais de saida de
cada slot;

6. Mapeamento ativo - Os quadrados de cor azul escura indicam os mapeamentos
que estdo ativos no equipamento.

7. Mapeamento padrao - Indicado pelos quadrados de cor azul clara, o

mapeamento padrao corresponde aos canais de rede que serdo atribuidos as saidas
caso o patchbay seja desabilitado.

8.4.3. Patchbay Local (Local Patch)

O patchbay local (Local Patch) é usado para fazer interconexdes entre entradas e saidas de
um mesmo equipamento, sem que o audio trafegue através da rede. Essa funcionalidade
permite que o DSnake seja utilizado como matriz de audio.

1. Botdo Local Patch - Clique nesse botdo para habilitar a exibicdo do patchbay
local;
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2. Canais de entrada - Na parte superior da janela sdo exibidos os canais de
entrada do equipamento selecionado, separados por slot. O nome do canal é
configurado através da janela Channel do DSManager;

INPUT PATCH
ADBPRE -5LOT 1 ADBPRE - 5LOT 2 ADBPRE - 5L0T 3
OUTPUT PATCH c
LOCAL PATCH
DS Modular Stage
i A
DS Modular Stage
C

DS Compact FOH

02 Snare Both
03 Floor Tom

04 Tom 3
03 Bck Yocal 2

01 Snare Top
05 Tom 2

06 Tom 1

07 Hi Hat

00 Dver L

01 Dver R
02 Bass DI
03 Ld Guitar
05 Trombone
06 Trumpet
07 Piano L
00 Piano R
01 Ld ¥ocal
02 Bek Yocal 1
04 Guest

05 Spare 1
06 Spare 2
0F Spare 3

Channel 2
Channel 3 -
Channel 4
Channel 5
Channel &
Channel 7 -
Channel 8
Channel 1

DS Modular Stag)
DAS - SLOT 4

Channel 2
Channel 3
Channel 4
Channel 5
Channel 6
Channel 7
Channel 8

DAB - SLOT 5

5
Figura 60. Patchbay local

3. Menu de Seleciao de Equipamento - Esse menu deve ser usado para
selecionar o equipamento do qual se deseja configurar o patchbay local.

4. Canais de saida - Na parte esquerda da janela sdo representados os canais de
saida do equipamento selecionado, separados por slots.

5. Mapeamento local - Clique com o botdo esquerdo do mouse na intersecgdo entre
o canal de entrada (coluna) e o canal de saida (linha) desejados para habilitar um
mapeamento local. Os mapeamentos ativos sdo representados por quadrados em cor
azul escura. Para remover um mapeamento existente, clique sobre ele com o botdo
direito do mouse.

8.5. Janela Equipments

A janela Equipments exibe informagdes e status de todos os equipamentos da rede. Para
acessa-la, clique no botdo "Equipments” na barra superior do DSManager (Figura 61).

Para cada equipamento s3o apresentadas as seguintes informagdes:

1. Equipment Name - Campo de texto (editdvel) que indica o nome do
equipamento. Esse é o mesmo nome exibido nas janelas Patchbay e Recorder;

2. Serial Number - Nimero de série do equipamento;

3. IP - endereqo - IP utilizado para gerenciamento;
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DSNAKE Network Management
File Edit Tools Help

[ Channel H

Patch | |

Equipments { ‘

Recorder 1

[ Muteal

H Peak Hold ]l Clip Clear l

%
Shake MODULAR

Equipment Name:
DS Modular 0005

Serial Number: 0000005
Ip: 176.0.1.103
HOPS:
Channel range:
Stacking:
Enable inputs:
Slot number:
Firmware: 1.11
25/06/10

23°C

Firmware Date:

Temperature:

ad
Shake MODULAR

Equipment Name:
DS Modular 0006
0000006
176.0.1.104
HOPS: 1
Channel range:
Stacking:
Enable inputs: ON
Slot number: 5
Firmware: 1.11
Firmware Date: 25/06/10

Temperature: 28°C

-
Shake MODULAR

Equipment Name:

DS Modular 0003
Serial Number: 0000003
IP: 176.0.1.105
HOPS:
Channel range:
Stacking:
Enable inputs:
Slot number:
Firmware: 1.6
Firmware Date: 23/06/10

31°C

rad

Equipment Name:

DS Modular 0007
Serial Number: 0000007
IP: 176.0.1.106
HOPS:

Channel range:

Stacking:

Enable inputs:

Slot number:

Firmware: 1.6

23/06/10
30°C

Firmware Date:

<

Power Source: OK

Temperature: Temperature:

Power Source: OK || Power Source: Not OK || Power Source: OK

PSPRO DSNAKE

Fonnected 6 Equipment(s)
Figura61. Janela Equipments
4. Hops - Indica quantos elementos de rede existem entre o computador e esse

8.
9.

equipamento. O equipamento conectado diretamente ao computador possui hops
igual a zero.

Channel Range - Indica a posicdo da chave “CH RANGE” que encontra-se no
painal equipamento. Essa chave s6 é utilizada quando o patchbay estiver
desabilitado;

Stacking - Indica a posicdo da chave
“RING/STACKING"” (DSnake Compact);

“"STACKING” (DSnake Modular) ou

Enable Inputs - Indica a posigdo da chave “"ENABLE INPUTS” do DSnake Compact.
No DSnake Modular, que ndo possuiessa chave, é exibida sempre a indicacdo "On”.

Slot Number - Exibe o nimero de slots que o equipamento possui;

Firmware - Exibe a versdo de firmware atual do equipamento;

10.Firmware date - Exibe a data de lancamento do firmware do equipamento;

11.Temperature - Mostra a temperatura intema atual do equipamento;

12.Power Source - Exibe o estado da fonte de alimentacdo (“*Ok” ou "Not Ok”).
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8.6. Cenas

O DSManager possui a funcionalidade de salvar e carregar cenas. As cenas sao arquivos
salvos em disco que contém as configuragdes de todos os equipamentos da rede.

Um arquivo de cena contém as seguintes configuragdes:
¢ Nomes dos equipamentos
e Nomes dos canais
e Configuragbes dos pré-amplificadores:
= Ganho
= Pad

=  Phantom power

=  Mute
=  Link
e Patchbay

e Taxa de amostragem do sistema

e Habilitacdo de gravacao dos canais (janela Recorder)

8.6.1. Salvando Cenas

Para salvar a cena atual em um arquivo, utilize o menu File -> Save Scene (Figura 62). A
extensdo padrao dos arquivos de cena do DSManager é dsf.

Edit Tools Help

Load Scene Ctrl+O
Save Scene Ctrl+5
Load Default Scene

Exit Ctrl+X

Figura 62. Salvando e carregando cenas.

8.6.2. Carregando Cenas
Para carregar uma cena previamente salva, acesse o menu File -> Load Scene.

Ao carregar uma cena, todas as configuragdes atuais serdao perdidas e as novas
configuracdes serdo automaticamente aplicadas.

8.6.3. Cena Padrao (Default Scene)

Ao carregar a cena padrao (menu File -> Load Default Scene do DSManager), todas as
configuragbes de todos os equipamentos voltardo ao valor padrao de fabrica.
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8.7. Atualizando o firmware do DSnake

Eventualmente, podem ser desenvolvidas novas fungdes ou melhorias nas fungdes atuais do
equipamento. Para que seu equipamento possua as funcionalidades mais recentes, é
necessario atualizd-lo com a ultima versdo de firmware disponibilizada pela DSPRO. Para
isso, conecte-se ao Dsnake através do DSManager e selecione a opgdo Firmware Update no
menu Tools (Tools -> Firmware Update). Vocé vera uma janela conforme a figura 63:

rE Firmware Update El =] @ﬁ

Equipment

DS Compact 0039 (1.15) [ w

Image File
C\DSPROVdsmodular 1-15.im |:|

Equipment: DSnake Compact Image: DSnake Modular

Firmware Version: 1.15 Image Version: 1.15

Warning: Do not turn off or disconnect the equipment during update.

Update Cancel

Figura 63. Janela Firmware Update

No campo Equipment selecione o equipamento cujo firmware sera atualizado. Ao selecionar
0 equipamento as informacdes de modelo e versao atual de firmware do equipamento serdo
atualizadas.

Selecione o arquivo de imagem de firmware no campo Image File. Apés selecionado, as
informagdes de modelo e versao de firmware da imagem serdo atualizadas.

Clique no botdo Update e aguarde a transferéncia da imagem ser completada.

Apds terminado o processo de atualizacdo, o equipamento serd reiniciado e o novo firmware
sera aplicado.

8.7.1. Escolha da interface para atualizacao

O DSnake pode ser atualizado tanto pela interface de rede quanto pela interface RS-232. No
entanto, a interface de rede, que utiliza o protocolo Fast Ethernet possui uma taxa de
transmissdo de dados consideravelmente mais rdpida do que a interface que utiliza o
protoclo RS-232. Por esse motivo, a DSPRO recomenda que a atualizacdo de firmware pela
interface RS-232 seja utilizada apenas em ultimo caso.

8.7.2. O que fazer caso a atualizacao seja interrompida

Se, por algum motivo, a atualizacdo de firmware for interrompida, nao desligue o
equipamento. Tente novamente até a atualizacdo ser completada com sucesso.

Caso o equipamento tenha sido reiniciado apds uma atualizagdo interrompida, leia a segdo
9.4.1.
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Obs: A mensagem “Equipment Rejected Update” significa apenas que o update ndo foi
iniciado no equipamento e, por ndo caracterizar uma interrup¢do na atualizacdo, nao
representa risco a funcionalidade do equipamento.

8.8. Selecionando a Taxa de Amostragem

O DSnake possui a capacidade de trabalhar com a taxa de amostragem de 48kHz ou 96kHz.
Para que o seu sistema funcione corretamente todos os equipamentos da rede devem estar
configurados para trabalhar com a mesma taxa de amostragem.

Para escolher a taxa de amostragem selecione no menu Edit a opcdao Sample Rate (Edit ->
Sample Rate ). Uma janela como a da figura abaixo ira abrir.

E Sample Rate Selection EI =] @

Cancel | | oK

Do not show warnings for different sample rates.

SAMPLE RATE EQUIPMENT NAME
48kHz DS Compact 0039
48kHz DS Modular 0003

Figura 64. Janela de selecdo de Taxa de Amostragem

Na parte superior da janela estdo as opgdes de taxa de amostragem, e a opgdo de nao
alertar caso os equipamentos estejam configurados com diferentes taxas (ndo
recomendado). Na parte inferior encontra-se uma lista com todos os equipamentos
conectados a rede e a taxa de amostragem que cada um esta trabalhando.

Ao clicar no botdo OK, todos os equipamentos serdo configurados para trabalhar na taxa
selecionada.
8.8.1. Consideracoes sobre as taxas de amostragem

Ao trabalhar com uma taxa de amostragem de 96kHz, maior quantidade de dados por canal
sera transmitida para a rede, por esse motivo o nimero de canais que uma rede de
equipamentos DSnake pode trabalhar a 96kHz é 40, contra 80 canais de uma rede
funcionando a 48kHz.
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8.9. Janela Recorder

O Recorder é a funcionalidade que permite ao DSManager operar como uma interface
simples e intuitiva de captura de audio através da placa de rede. Para ter acesso a janela de
gravacao, clique no botdo Recorder da barra superior do DSManager.

O DSManager pode gravar todos os canais da rede simultaneamente em arquivos separados.
O formato do arquivo de saida é wave, sem compressdo, com taxa de amostragem de 48kHz
ou 96kHz, de acordo com a configuracao da rede.

Os elementos da janela de gravagdo estdo indicados na Figura 65.

1. Pasta de gravacgao - Esse campo mostra a pasta em que os arquivos de dudio
serao salvos. Para selecionar outra pasta, use o botdo Change Folder;

B nsRecorder . E

.. o U‘lﬂm;t_ s .'_

O0z00:00 Track tme

|
00:00:00 Total time | . ‘ . m
04:52:34 | Time remaining e

Illl

Refresh pterface

Hide channals J
EQUIPHMENT - 5LOT - PORT - MAP CHANNEL NAME WU METER ENABLE

DS ModularODDZ -1-1- 15

TT l 888 9

) :
D5 Modular 0003 - 1 fom 3 |
05 Modular 0003 - 1 - :
5 Modular DDD3 - 1 ; spare motbon
xS Modular D003 - 1 Hi-hat

S Modular D003 - 2 - 23 YEM L

D5 Modular 0003 - 2 wmr R
05 Modular 0003 - 2 - 3 - 2 EE
& Modular 0003 - 2 - 4 - |
5
05 Modular 0003 - 2 - 6§ - Pigns A
DS Modular 0002 -2 - 7 symth
Ld woLal

DS Modular 0003 - 2-8- 3

s Modular 0003 - 2

D5 Modular 0003 -3 - 1 - ;
D5 Modular 0003 - 3 - 2 - 3 Spare 8 |

sdliilar DO - .3 - 3 Epare 2

Figura65: Janela Recorder

2. Tempo atual da faixa - Exibe o tempo de gravacdo da faixa atual;
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10.

11

12,

13.

. Tempo total de gravacao - Exibe o tempo total de gravacdo, somando todas as

faixas gravadas;

Tempo restante de gravacao - Mostra o tempo de gravacio restante no disco
rigido;

Botao Show Channels/Hide Channels - Clique nesse botdo para exibir ou

ocultar a lista dos canais;

Nome do canal - esse campo permite visualizar e editar o nome dos canais. Os
nomes sao 0S Mesmos que aparecem nas janelas Channel e Patch, bem como no
nome dos arquivos de audio.

Informacoes adicionais do canal - esse ampo exibe 0 nome do equipamento

e do slot a que o canal de entrada pertence, bem como o canal da rede para o qual
ele estd mapeado.

Botdao Change Folder - permite selecionar uma nova pasta de gravacio
Bot3ao Record - pressione esse botdo para iniciara gravagido

Botdao Skip Track - esse botdo fecha os arquivos .wav de saida e continua a
gravacdo em arquivos novos. Esse recurso permite separar a gravacdo por faixas,
facilitando a edicdo posterior.

.Botao Stop - encerra a gravacdo e fecha os arquivos wav.

Botao Enable - esse botdo permite selecionar quais canais serdo gravados.
Somente 0s canais com o cujo botdo enable estd ligado (vermelho) serdo salvos em
arquivo. Quanto maior o nimero de cnais gravados simultaneamente, maior a
quantidade de processamento exigida do computador.

Medidor de nivel - indica o nivel do sinal de entrada, de forma semelhante ao
medidor da janela Channel.

Os nomes dos arquivos de saida seguem ao seguinte padrdo:

Onde:

NN_NAME_TRACK.wav

- NN é o nimero do canal na rede
- NAME é o nome do canal (configurado pelo usuario)

- TRACK é o numero da faixa (comegando em 0)

1000.0003.0002 Manual do Usuario — DSnake

56



9. SOLUCIONANDO PROBLEMAS

Nesta segdo serdo explicadas as possiveis causas e solugdes para eventuais problemas que
vocé pode encontrar ao utilizar o DSnake.

9.1. O dudio de um canal ndo é transmitido para a saida

9.1.1. O canal ndo esta mapeado corretamente para a saida

Para que um @nal de um equipamento seja transmitido para um anal de outro
equipamento, é preciso que o canal de entrada esteja mapeado para algum canal da rede e o
canal de saida esteja utilizando o mesmo canal da rede como origem.

Solugao: Conecte-se ao equipamento através do DSManager. Na janela Patchbay, selecione
a opcgao Input Patch. Localize o canal de entrada correspondente ao equipamento, slot e
numero do canal de entrada em questdo. Selecione um canal da rede para o qual o canal de
entrada sera mapeado. Em seguida selecione a opgdo Output Patch. Localize o canal de saida
correspondente ao equipamento, slot e nimero do canal de saida em questdo. Selecione o
mesmo canal da rede para o qual o canal de entrada foi mapeado, como origem para o canal
de saida.

Para maiores informagdes sobre Patchbay veja o capitulo 8.4 - Janela Patchbay.

9.1.2. Um equipamento intermediario ndo esta habilitado para
retranstimitir o audio recebido.

Para que o audio de um equipamento seja transmitido para outro, sem que ambos estejam
diretamente conectados um no outro, € necessario que o(s) equipamentos(s) que esta(do)
entre os dois esteja(m) com sua funcdo stacking habilitada.

Solugao: Localize, no equipamento intermediario, a chave de comutacao indicada pelo rétulo
STACKING. Mude a chave para a posicdo ON. O LED STACKED deve acender e o audio que
entra na porta BACKUP serd transmitido para a porta MAIN e o audio que entra na porta
MAIN sera transmitido para a porta BACKUP.

9.1.3. Um equipamento intermediario esta utilizando o mesmo canal da
rede para transmitir audio.

Caso o equipamento de transmissdo do audio do canal selecionado ndo esteja conectado
diretamente ao equipamento recepcdo, é preciso que o(s) equipamentos(s) que esta(do)
entre os dois ndo transmita(m) audio no mesmo canal da rede para o qual estd mapeado o
canal de entrada de dudio em questdo.

Solugao: Conecte-se ao equipamento através do DSManager. Na janela Patchbay, selecione
a opcao Input Patch. Localize o canal da rede para o qual o canal de entrada desejado esta
mapeado, desmapeie qualquer outro canal de entrada que esteja mapeado para 0 mesmo
canal da rede.
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9.1.4. O equipamento de transmissdao de audio esta conectado a outros
através da porta SPLIT (Somente DSnake Modular).

A porta SPLIT é utilizada apenas como porta de transmissdo de audio, qualquer audio que
entre nessa porta serd ignorado pelo equipamento.

Solugdao: Deswnecte qualquer cabo que esteja conectado na porta SPLIT no sentido canal
de entrada -> canal de saida e conecte-o na porta MAIN ou BACKUP do equipamento que
esteja recebendo o audio.

9.1.5. As entradas do equipamento estdao desabilitadas (Somente DSnake
Compact).

O modelo DSnake Compact possui a funcdo enable inputs. Caso esta funcdo seja desabilitada
0 equipamento ndo transmitird nenhum audio que entre nos seus canais loais.

Solucgao: Localize a chave de comutacdo indicada pelo rétulo ENABLE INPUTS. Mude a chave
para a posicdo ON. O LED ENABLE INPUTS deve acender e o audio que entra nos canais dos
slots de entrada é transmitido para a rede.

9.1.6. O canal esta mudo.

O equipamento salva a Ultima configuracdo aplicada, caso algum canal tenha sido mutado
anteriormente, ele vai permanecer assim até que outra configuracdo seja aplicada.

Solugao: Conecte-se ao equipamento através do DSManager. Na janela Channel, localize o
canal de entrada correspondente ao equipamento, slot e nimero do canal de entrada em
questdo. Pressione o botdo indicado pelo rotulo mute. O botdo deve perder sua cor vermelha
e o audio deste canal deve ser ouvido na saida.

9.1.7. Existem equipamentos trabalhando com diferentes taxas de
amostragem.

Caso existam equipamentos trabalhando com taxas de amostragem diferentes, o audio
transmitido entre eles sera ignorado.

Solugao: Conecte-se ao equipamento através do DSManager. Selecione no barra de menus
Edit -> Sample Rate. Selecione a taxa de amostragem que vocé deseja trabalhar.

9.2. 0 DSManager nao conecta ao equipamento pela porta
Ethernet

9.2.1. Suas configuracoes de IP ndo estdao configuradas corretamente.

Para utilizar o DSManager corretamente é necessario que as configuracdes do seu
computador estejam de acordo com o recomendado pela DSPRO

Solugao: Configure o PC com um IP na rede 176.0.x.x, com mascara de rede 255.255.0.0.
Para informacgdes detalhadas veja o capitulo 8.2.2 - Conexdo via porta Ethernet.
9.2.2. Seu firewall esta bloqueando o acesso da aplicacdo a rede.

Para que o DSManager funcione corretamente € necessario que ele possua acesso irrestrito a
rede a qual seu computador estd conectado. Seu aplicativo de firewall pode bloquear o
acesso, impedindo, dessa forma, o funcionamento correto do DSManager.
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Solucao: Verifique suas configuracdes de firewall e garanta que o DSManager possua acesso
liberado a rede.

9.3. LED de link nao acende mesmo com cabo conectado.

9.3.1. O cabo que conecta ambos equipamentos esta danificado.

O manuseio de qualquer tipo de cabo pode levar a danos a estrutura do cabo como quebra
ou oxidagdo. Esses danos prejudicam a comunicagao realizada entre os equipamentos.

Solugao: Troque o conector RJ45 ou utilize outro cabo para realizar a conexao.
9.4. LEDs do painel piscam uniforme mente

9.4.1. Uma atualizacdo de firmware foi mal-sucedida.

Quando o firmware do equipamento estd corrompido ele carrega o firmware de inicializacado.
O firmware de inicializacdo ndo é compativel com o DSManager e, por esse motivo, ndo é
possivel recuperar o firmware através do mesmo.

Solugao: Contate a DSPRO para obter o aplicativo de recuperacao de firmware.

9.4.2. O equipamento esta trabalhando a uma temperatura muito elevada.

Quando o equipamento estiver trabalhando a uma temperatura fora de suas especificacoes,
ele piscara todas a luzes do painel. Expor o equipamento a condigbes extremas pode causar
mal funcionamento e, se por periodo prolongado, danos permanentes.

Solugdo: Desligue o equipamento, desobstrua a ventilagdo e proteja o equipamento do sol e
de ambientes com temperaturas muito altas.

9.5. 0 medidor de nivel de um canal ndo aparece corretamente.

9.5.1. O canal ndo esta mapeado para a rede.

O medidor de nivel do DSManager indica apenas os canais presentes na rede, canais nao
mapeados ou canais mapeados apenas localmente ndo possuem indicagdo de nivel na janela
Channel do DSManager. O gerenciamento desses canais, no entanto, permanece funcional
independentemente de estarem mapeados ou nao.

Solugao: Para visualizar o medidor de nivel de determinado canal, basta maped-lo para

qualquer canal da rede, ndo sendo necessario que alguma saida esteja mapeada para ele.

9.6. O gravador nao reconhece os canais de entrada presentes

9.6.1. Os canais nao estao mapeados para a rede.

Para que qualquer canal seja habilitado para gravacdo € necessario que ele esteja presente
na rede.

Solugao: Basta mapear o canal que se deseja gravar para algum canal da rede.

9.6.2. A fungao stacking esta desabilitada.

Caso os canais que se deseja gravar ndao estejam presentes no equipamento conectado
diretamente no seu PC, a fungdao stacking deve estar habilitada. A fungdo stacking garante
que o audio recebido em uma porta Ethernet seja transmitido para as demais.
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Solugao: Localize no equipamento a chave de comutacdo indicada pelo rétulo stacking.
Mude a chave para a posicao ON e o LED STACKED deve acender.

9.7. LEDs de Channel Range piscam uniforme mente.

9.7.1. O equipamento esta configurado para utilizar os canais altos da rede
e taxa de amostragem de 96kHz.

Quando estiver utilizando taxa de amostragem de 96kHz apenas os canais de 1 a 40 da rede
estardo disponiveis.

Solugao: Existem 3 solucGes possiveis para o problema, sdo elas:

9.7.1.1. Modificar a posicdo da chave CHANNEL RANGE para a posicdao 1..40
(canais baixos).

9.7.1.2. Modificar a taxa de amostragem para 48kHz através do DSManager.

9.7.1.3. Habilitar o patchbay através do DSManager

9.8. Canais de entrada do DSnake Compact nao aparecem.
9.8.1. As entradas do equipamento estiao desabilitadas (Somente DSnake
Compact).

O modelo DSnake Compact possui a fungdo ENABLE INPUTS. Caso esta fungdo seja
desabilitada os canais de entrada do equipamento ndo serdo reconhecidos pelo DSManager.

Solugdo: Localize a chave de comutacdo indicada pelo rétulo ENABLE INPUTS. Mude a chave
para a posicdo ON e a luz de indicagdao inputs enabled deve acender.
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10. ESPECIFICAGOES TECNICAS

10.1. DSnake Modular (DS-MOD)

NUmero maximo de canais 40
NUmero de slots 5
Interfaces digitais DSPRO 4

Médulos suportados

DSM-AD8PRE e DSM-DA8

Dimensodes (L x A x P)

488,0 x 177,8 x 188,2 mm

Alimentacao 90 a 250 VAC 50/60Hz
Poténcia maxima 150w
Massa 4,72kg(*1)
(*1) Sem modulos de IO
. 488,0 |
|
o] ° =
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188,2

= = in g

Figura 66. Dimensfes DSnake Modular
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10.1.1. Médulo AD8PRE (DSM-ADS8SPRE)

Interface Entrada de microfone ou linha
Namero de canais 8
Conector XLR
Taxa de Amostragem 48 ou 96kHz
Numero de bits 24
Ganho 0 a 55dB (passos 1db)
Phantom +48V
Pad 26dB
Impedancia de entrada 3,6kOhms
Nivel maximo +22dBu
Range dindmico 110dB (*1)
EIN -120dB (*2)

THD+N Analdgico > Digital

<0,001% (*3)

THD+N Analdgico > Analdgico

<0,003% (*3)

Resposta em freqliéncia

+/-0,4dB (20Hz a 20kHz)

Massa

0,360kg

(*1) Medido com filtro passa faixa de 20-20kHz, sem ponderagdo

(*2) Medido com ponderagao A
(*3) 1kHz, -10dBFS, 0dB ganho

T =)

DSNAKE ADB-FRE &

123458678

Figura67. Mddulo ADSPRE (DS M-ADSP RE)

10.1.2. Médulo DAS (DSM-DAS)

Interface Saida balanceada de linha
NUmero de canais 8
Conector XLR
Taxa de amostragem 48 ou 96kHz
Numero de bits 24
Impedancia de saida 100 Ohms
Nivel maximo +22dBu
Range dinamico 110dB(*1)

THD+N Digital > Analdgico

<0,001% (*2)

THD+N Analdgico > Analdgico

<0,003% (*2)

Resposta em freqliéncia

+/-0,4dB (20Hz a 20kHz)

Massa

0,320kg

(*1) Medido com filtro passa faixa de 20-20kHz, sem ponderagdo

(*2) 1kHz, -10dBFS, 0db ganho

= OIS
DSMAKE DAS

Figura 68. Modulo DA8 (DS M-DAS)
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10.2. DSnake Compact (DS-COMP)

NUmero maximo de canais 64
Numero de slots 8
Interfaces digitais DSPRO 2
Médulos suportados DSM-AD8C e DSM-DASC
Dimensdes (L x A x P) 483,6 x 43,9 x 339,5 mm
Alimentagao 90 a 250VAC 50/60Hz
Poténcia maxima 120W
Massa 4,6kg(*1)

(*1) Sem madulos de 10
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Figura 69. Dimensdes DSnake Compact
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10.2.1. Médulo Compact AD8 (DSM-ADSC)

Interface Entrada balanceada de linha
Nimero de canais 8
Conector DB25
Taxa de amostragem 48 ou 96kHz
Numero de bits 24
Ganho 0dB
Impedancia de entrada 8,6 kOhms
Nivel maximo +22 dBu
Range dindmico 110dB (*1)

THD+N Analdgico > Digital

<0,001% (*2)

THD+N Analdgico > Analdgico

<0,003% (*2)

Resposta em freqUiéncia

+/-0,4dB (20Hz a 20kHz)

Massa

0,125kg

(*1) Medido com filtro passa faixa de 20-20kHz, sem ponderagdo

(*2) 1kHz,-10dBFS

M G 00000000 00 oI
o | PR | o

Figura 70. Médulo Compact AD8 (DS M-ADSC)

10.2.2. Médulo Compact DASC (DSM-DASC)

Interface

Saida balanceada de linha

Namero de aanais 8
Conector DB25
Taxa de amostragem 48 ou 96kHz
Ndmero de bits 24
Impedancia de saida 100 Ohms
Nivel maximo +22 dBu
Range dinamico 110dB(*1)

THD+N Analdgico > Digital

<0,001% (*2)

THD+N Analdgico > Analdgico

<0,003% (*2)

Resposta em freqliéncia

+/-0,4dB (20Hz a 20kHz)

(*1) Medido com filtro passa faixa de 20-20kHz, sem ponderagao

(*2) 1kHz,-10dBFS

:"- C0000000000 0 o =4
iposssssnsnaal o

Figura71. Mo6dulo Compact DA8C (DS M-DA8C)
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10.3. Protocolo DSPRO

Taxa de Amostragem 48kHz
Numero de canais 80
Numero de bits 24
Atraso do Protocolo 500 us
Atraso Analdgico<>Analdgico 2.1ms

Taxa de Amostragem 96kHz
Ndmero de canais 40
Numero de bits 24
Atraso do Protooolo 500 us
Atraso Analdgico<>Analogico 1.35ms
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ANEXO I - PINAGEM DB25

O Conector DB25 dos mddulos de I0 DSM-AD8C e DSM-DASC, possui a seguinte funcdo para
seus pinos:

DB25 XLR Canal
1 +HOT 2
14 -coLD 8 8
2 G GROUND 1
15 +HOT 2
3 -CoLD 3 7
16 G GROUND 1
4 +HOT 2
17 -coLb 3 6
15 G GROUND 1
18 +HOT 2
6 -coLD 3 5
19 G GROUND 1
7 +HOT 2
20 -coLb 3 4
8 G GROUND 1
21 +HOT 2
9 - COLD 3 3
22 G GROUND 1
10 +HOT 2
23 -coLD 3 2
11 G GROUND 1
24 +HOT 2
12 -CcoLD 3 1
25 G GROUND 1

] 2] _[s] _[4f _[s] _[e] _[7] _[s]

GCHGCHGCHGCHGCHGCHGCHGCH \

1B30 120 |10 (100 |90 |80 |70 |80 |50 |40 |30 |20 | 10
%0 240 BO 2O 210 200 190 18O 11O 180 18D 140/

H=HOT
C=COoLD
G = GROUND

Figura 72. Pinagem Conector DB25

Para o mddulo de Entrada DSM-AD8C, o cabo contém 8 XLR Fémea da seguinte forma:
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Figura 73. Diagrama do cabo para DSM-AD8C

PHASE Termination Point
POSITIVE + PIN 2
NEGATIVE - PIN 3

SIGNAL GROUND ¥ |P|N 1
CHASSIS GROUND ~#* |CASE

POSITIVE

NEGATIVE

DRAIN

XLR FEMALE
0O,
®

PIN2 +
PIN3 —
PIN1 +
CASE -7 N/C

REAR CASE (SOLDER SIDE)

Figura74. Pinagemconector XLR Fémea (Vista Traseira)

Para o médulo de saida DSM-DA8C, o cabo contém 8 XLR Macho da seguinte forma:

Figura 75. Diagrama do cabo para DSM-DA8C
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PHASE Termination Point
POSITIVE + PIN 2
NEGATIVE « PIN 3

SIGNAL GROUND ¥ |[PIN 1
CHASSIS GROUND /77 |CASE

POSITIVE

NEGATIVE

DRAIN

XLR MALE

®®
®

PIN2 +
PIN3 —
PIN1 <+

CASE ~# N/C

REAR CASE (SOLDER SIDE)

Figura76. Pinagem conector XLR Macho (Vista Traseira)
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ANEXO II - RJ45

As portas Ethemet dos equipamento da familia DSnake possuem detecgdo de cruzamento de
cabo permitindo que sejam utilizados cabos com qualquer uma das duas montagens padrao,
EIA568A ou EIA569B, também conhecidas como reta e cruzada.

TIA/EIA 568A Wiring

[0 [0 [0 [0 ] White and Green

[ | Green

[T 0 7T T | white and Orange
N Blue

(I TN T ] white and Blue
[ Orange

[ T T W | white and Brown
I Brown

[-- LN - L .- LI

TIA/EIA 568B Wiring

07T 0 T°T T ] White and Orange
) Orange

[0 000 0 [0 ] White and Green
[ Blue

[ T I B | white and Blue

[ | Green

[ T T W | white and Brown
I Brown

(= I I - R T T N

Figura77.Pinagem Cat5E EIA568A/B

Pair2 - Orange

Blue

Pair 1

T

RJ-45 Jack

RJ-45 Plug

ANSIITIAIEIA 568A
Network Interface

Brown
Brown-White
Orange
Blue-W hite
Blue
Orange-Wf hite
Green
Green-W hite

SN0 G0N ©

- a —

Figura 78. Ordem dos pinos do RJ45
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CONTATOS

Para contatar o suporte técnico, ou o setor de vendas:

e Suporte: suporte@dspro.com.br
e Vendas: vendas@dspro.com.br
e Fone: +55 51 3287-2152

e Fax: +5551 3287-2092

e Site: www.dspro.com.br

e Enderecgo:

DSPRO

Av. Washington Luiz, 675 sala 1116
CEP: 90.010-460 - Centro

Porto Alegre, RS - Brasil
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